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Introduction 
Welcome to Microsoft® Office 2003 Editions, the easiest way to help more people use 
information to make a positive impact on business. The Office 2003 Editions offer new 
technologies and features while improving upon existing and familiar tools to facilitate effective 
and efficient collaboration and information sharing. 

Through integration with Microsoft Windows® SharePoint™ Service, the Office 2003 Editions 
offer advances in intranet collaboration to help users gain access to and share information both 
internally and externally. Support for Information Rights Management (IRM), and industry-
standard Extensible Markup Language (XML) provides a platform on which to build cost-
effective solutions that can have an immediate, positive impact. In addition, the Office 2003 
Editions offer new ways to organize and manage e-mail and make more use out of the workday. 

Design Goals 
With a focus on connecting people, information, and business processes, the design goals 
integrate collaboration, usability, and information management. 

Connect people 
Designed to integrate with intranet technologies such as Microsoft Windows® 
SharePoint Services, the Office 2003 Editions provide new ways to connect individuals, 
teams, and organizations. By incorporating the new tools with familiar Microsoft Office 
menus, functions, and interfaces, training and implementation time is minimized. 
Workers can collaborate from any location by using shared information and simplified 
review processes, including the following features:  

• New! Shared Workspace Task Pane facilitates and simplifies efficient 
collaboration and document sharing. 

• New! Shared Attachment Option offers an automatic way of creating 
Document Workspaces through e-mail messages, when sending attachments for 
review. Document Workspaces then provide a forum for managing collaborative 
review and projects, with features such as automatic updates to the most 
current version, and the ability to share documents and other relevant 
information in real time. 

• New! Meeting Workspace Option automatically creates workspaces through 
Outlook invitations. Meeting Workspaces help enhance the productivity of 
meetings by providing a place to coordinate schedules, disseminate materials, 
and store notes and minutes. 
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• New! Instant messaging (IM) and alerts technology is integrated throughout 
the Office 2003 Editions collaboration tools, providing instant information and 
the ability to initiate IM conversations quickly from within documents, Shared 
Workspaces, or Microsoft Office Outlook 2003.  

• Improved! Contacts and calendars can be shared easily among team members 
and viewed side-by-side to facilitate meeting coordination and scheduling.  

• New! Information Rights Management (IRM) functionality protects sensitive 
information from unauthorized distribution or alteration, and allows companies 
to set and enforce policies that help control how their data is used. 

• New! Word 2003 Formatting and Editing Restrictions maintain formatting 
structure and document integrity. 

Connect information 
The Office 2003 Editions are designed to make it easier for people to manage an ever-
increasing volume of business information. Improvements and new features in 
Outlook 2003 enable users to organize and prioritize e-mail messages quickly and easily, 
and new security settings offer increased support for junk e-mail filtering. Support for 
remote and mobile workers includes improvements to connectivity performance, such 
as better caching, and shared calendars. Obtaining information from a variety of 
locations is made easier with organizational tools, such as the Research Task Pane. The 
following are new and improved features for connecting information: 

• New! New Mail View, Reading Pane, and Navigation Pane in Outlook 2003 
work together to give users a more comprehensive, organized view of their e-
mail messages, with more efficient use of screen space. 

• New! Outlook 2003 Search Folders provide an easy, automated way to organize 
e-mail messages without physically moving them. Users can create customized 
Search Folders based on their business needs. 

• New! Outlook 2003 Quick Flags provide one-click marking of e-mail messages 
that require action. 

• Improved! Remote and mobile access includes improved Outlook 2003 
connectivity and better caching. 

• Improved! Enhanced Rules and Alerts provide automated organization of 
incoming e-mail messages, in addition to automatic notifications so that users 
can stay current with incoming e-mail messages without spending extra time 
doing so. Alerts can also be integrated with Document Workspaces to notify 
users about important project developments. 

• Improved! Accessing needed information is more efficient with the Research 
Task Pane. 

• Improved! E-mail security enhancements help stop incoming messages that 
contain viruses, improve junk e-mail filtering, and block unsolicited attachments 
from communicating back to the originating servers. 

• Improved! Enhanced ink support provides a better experience overall when 
using Tablet PCs, offering support for handwritten e-mail messages and the 
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ability to write directly in Word 2003, Microsoft Office PowerPoint® 2003, and 
Microsoft Office Excel 2003 documents. 

Connect business processes 
Often critical business information is kept separate from the programs that workers 
know and use. With its extensive support for industry-standard XML, the Office 2003 
Editions help bring business processes and information together on the desktop. To 
facilitate greater efficiency, features such as Smart Documents and Programmable Task 
Panes help users to share customizable, task-specific information easily. New and 
improved tools for connecting business processes include the following features:  

• New! Customer-defined XML schema support is available in Word 2003 and 
Excel 2003. 

• New! Smart Documents bring relevant information directly to the task at hand 
through a new Programmable Task Pane user interface. With Smart Documents, 
XML solutions can be created to enable business processes, help users complete 
forms and other documents, and then link that information to back-end systems 
that support XML. As the user clicks through the document, the program is 
modified to present the appropriate functions to complete the task. 

• New! Extensible Smart Tag support is now offered in all the Office programs 
including PowerPoint 2003, Outlook 2003, and Microsoft Office Access 2003. 
Support includes automatic configuration capabilities such as formatting and 
populating an index at the end of an article. 

• New! XML support for Word 2003 includes content management options, data 
reporting, content repurposing, and data mining.  

• Improved! XML support for Excel 2003 and Access 2003 offers increased 
flexibility for importing XML files of any schema. 
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System Recommendations 
To use the Office 2003 Editions, you need to meet the following system requirements: 

• Personal computer with an Intel Pentium 233-megahertz (MHz) or faster processor 
(Pentium III recommended) 

• Microsoft Windows® 2000 with Service Pack 3 (SP3) or later; or Windows XP or later 
• Super VGA (800 × 600) or a higher-resolution monitor 
• 128 megabytes (MB) of RAM or more  

Hard disk usage will vary depending on configuration; custom installation choices may 
require more or less hard disk space. The following are the hard disk requirements for 
individual Office 2003 Editions. 

Microsoft Office Professional Edition 2003  

• 400 MB of available hard disk space; 190 MB of hard disk space for Microsoft 
Office Outlook® 2003 with Business Contact Manager  

• Optional installation files cache (recommended) requires an additional 290 MB 
of available hard disk space  

Microsoft Office Small Business Edition 2003  

• 380 MB of available hard disk space; 190 MB of additional hard disk space to use 
the optional installation of Outlook 2003 with Business Contact Manager  

• Optional installation files cache (recommended) requires an additional 280 MB 
of available hard disk space  

Microsoft Office Standard Edition 2003  

• 260 MB of available hard disk space  
• Optional installation files cache (recommended) requires an additional 250 MB 

of available hard disk space  
Microsoft Office Student and Teacher Edition 2003  

• 260 MB of available hard disk space  
Optional installation files cache (recommended) requires an additional 250 MB of 
available hard disk space 



 

 
 
 

10 

Additional Items or Services 
Some features or advanced functionality have additional requirements. 

Microsoft Office Professional Edition 2003 

To use the optional installation of Outlook 2003 with Business Contact Manager, you 
need to meet the following system requirements: 

• A PC with a Pentium 450-MHz or faster processor  
• 260 MB of RAM or more recommended  
• 190 MB of additional hard disk space  
• For speech recognition:  

• Pentium II 400-MHz or faster processor.  
• Close-talk microphone and audio-output device.  

• Microsoft Exchange Server is required for certain advanced functionality in 
Outlook 2003.  

• Microsoft Windows Server™ 2003 running Windows SharePoint™ Services is 
required for certain advanced collaboration functionality.  

• Internet functionality requires dial-up or broadband Internet access provided 
separately; local or long-distance charges may apply.  

• Certain inking features require running Microsoft Office on the Microsoft 
Windows XP Tablet PC Edition.  

• Information Rights Management features require access to a Microsoft 
Windows 2003 Sever running Windows Rights Management Services. 
Note  Business Contact Manager will be disabled in the presence of an 
Exchange-technologies-based e-mail system. 

Microsoft Office Small Business Edition 2003 

• To use the optional installation of Outlook 2003 with Business Contact Manager 
you need to meet the following system requirements:  
• A PC with a Pentium 450-MHz or faster processor.  
• 260 MB of RAM or more recommended.  
• 190 MB of additional hard disk space.  

• For speech recognition:  
• Pentium II 400-MHz or higher processor.  
• Close-talk microphone and audio output device.  

• Exchange is required for certain advanced functionality in Outlook 2003.  
Note  Business Contact Manager will be disabled in the presence of an 
Exchange-technologies-based e-mail system.  

• Windows Server 2003 running Windows SharePoint™ Services is required for 
certain advanced collaboration functionality.  

• Internet functionality requires dial-up or broadband Internet access provided 
separately; local or long-distance charges may apply.  
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Office Standard Edition 2003 

• For speech recognition:  
• Pentium II 400-MHz or faster processor.  
• Close-talk microphone and audio-output device.  

• Microsoft Exchange Server is required for certain advanced functionality in 
Outlook 2003.  

• Microsoft Windows Server™ 2003 running Windows SharePoint™ Services is 
required for certain advanced collaboration functionality.  

• Internet functionality requires dial-up or broadband Internet access provided 
separately; local or long-distance charges may apply.  

• Certain inking features require running Microsoft Office on the Microsoft 
Windows XP Tablet PC Edition.  
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Introduction  
Every employee faces challenges when a project requires team collaboration.  
The Microsoft® Office 2003 Editions and the integration with Microsoft Windows® SharePoint™ 
Services (WSS) provides a platform that includes programs employees use daily to work with 
other team members in a centralized location, making the team’s work more effective and 
efficient. 

The Office 2003 Editions allow for closer teamwork experience. New task panes from within the 
documents and e-mail messages provide information about other team members and also offer 
access to resources. Team members can use instant messenger (IM) integration to see when 
other team members are online or offline. New calendar features in Microsoft Outlook® 2003 
make scheduling meetings with other team members quicker and more effective. The 
Office 2003 Editions also offer content protection rights to authors, ensuring that authors have 
complete access to and control over their documents. 

Collaboration challenges 
Scheduling and communication typically require a great deal of back-and-forth 
interaction, and employees in different locations often have difficulty contacting each 
other. Until now, collaboration technology has been difficult to use without introducing 
a lot of infrastructure. 

Providing a platform for effective teamwork 
With WSS, the Office 2003 Editions gain new and enhanced tools for working on a 
shared document, communicating the status of a project, finding a teammate online, or 
adding comments or results to a shared worksite. This collaborative workspace 
environment is available wherever the Microsoft Office System of programs or a simple 
Web browser is installed.  

New feature highlights 
The Office 2003 Editions and WSS integrations facilitate collaborative work on projects, 
and make these projects efficient and effective. Task panes, such as the Shared 
Workspace task pane, show lists of the collaborating team members, their online status, 
collaborative lists of tasks, and relevant documents about and hyperlinks to the 
SharePoint site to the author—giving the author multiple information sources within the 
immediate work area.  
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While working with a Shared Workspace or Document Workspace, the author can use 
the new instant messaging integration to determine whether other team members are 
online or offline, which makes the availability of contacts obvious. Outlook 2003 also 
allows teams to share calendars and contacts, giving all team members access to 
important scheduling and information resources. Through these team-oriented 
features, collaborative work becomes more efficient. 

New content protection features include Information Rights Management (IRM) and 
Formatting and Editing Restrictions. IRM is a new policy enforcement technology in the 
Microsoft Office 2003 Editions that helps persistently protect sensitive documents and 
e-mail messages from unauthorized use. IRM helps reduce the risk of having 
confidential e-mail messages and documents fall into the wrong hands, whether by 
accident, carelessness, or some degree of malicious intent. In the Professional version of 
Office 2003 Editions, document owners can identify authorized recipients and set 
allowable actions. In all of the Editions, authors can also use the Formatting Restriction 
in Microsoft Office Word 2003 to define specific styles for a document, which reduces 
the amount of time that might be needed to reformat a document that has been 
created collaboratively. In addition to determining specific styles for a document, 
authors can protect individual parts of a document. By using the Editing Restriction 
feature in Word 2003, authors can assign specific sections to specific team members. 
The team members can only change content within their assigned regions, which 
decreases the author’s time when the various parts of a document are integrated.  

Key functionality  
Team projects are becoming more common and depend on seamless communication among 
team members. When a new team forms, the team members need to focus on the project’s 
tasks rather than worrying about the tools that they should use to accomplish those tasks. The 
Office 2003 Editions and WSS integrations employ easy-to-use tools and offer powerful 
functionality that helps enhance the success of a team’s collaboration efforts.  

The Shared Workspace task pane, which is available in Word 2003, Microsoft Office Excel 2003, 
and Microsoft Office PowerPoint® 2003, allows users to view other authors’ online status. It also 
provides a central location for several lists that each team member can contribute to, keeping 
the entire team up-to-date and informed.  

Document Workspaces bring all of a user’s resources, in addition to the team-collaboration 
context that is established in the Shared Workspace task pane, into the user's specific 
Office 2003 program. The user can view the progress of a document without having to resort to 
long e-mail chains, and can view the latest copies of the document while other team members 
continue their own work.  

Integrated Web discussions allow reviewers, authors, and editors to work together more 
efficiently by providing inline discussion tools and by storing inline discussion comments on a 
SharePoint site. Comments are directly added to a document that is stored and managed 
centrally so each team member has access to the most accurate version. 
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Meeting Workspaces provide a secure and centralized online site for all meeting-related 
communication, documents, and logistics. They create organized meetings where each team 
member can capture up-to-date information about a project, regardless of his or her proximity 
to the physical meeting space.  

The File menu in most Office 2003 Edition programs has been updated to include commands for 
shared documents on a SharePoint site. The File menu allows the user to open or save 
documents in a document library and add or update metadata in a document. 

Version tracking is also a key functionality of WSS. Users can view previous versions of Office 
2003 Edition and Office documents that are stored on a SharePoint site to find information that 
was deleted from the documents.  

Document check-in and checkout methods have also been improved. WSS allows a user to check 
out Office 2003 Edition or other Office documents that are stored in a document library; 
however, other users are prohibited from making any changes to the checked out document. 
After the user checks in the document, other users can resume work on the document. 

Shared Workspace Task Pane 
When a user opens a document that is located on a WSS site, whether it is an Internet 
Web site, a Document Workspace site, or a Meetings Workspace site, the Office 2003 
program that opens the document provides a special task pane that shows relevant 
information about that site. This pane displays information such as the list of people 
that are collaborating in the workspace and their online status, a list of tasks, other 
documents in the Shared Workspace library, relevant hyperlinks, and other information.  
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Opening the Shared Workspace task pane 

Word 2003, Microsoft Office Excel 2003, and Microsoft Office PowerPoint® 2003 will 
display the Shared Workspace task pane when the user opens a document that resides 
on a SharePoint site. 

 
A document showing the Shared Workspace task pane that includes the list of people who are 
collaborating on the document. 

Aggregating key collaboration tools  

The Shared Workspace task pane is not just view-only; it allows a user to invite new 
contributors to the workspace; create or assign tasks, or mark them as completed; 
upload additional documents; view other documents in the library; and add or follow 
hyperlinks that relate to the document. Also, integration of the task pane with instant 
messaging technology allows the user to see who is online through the familiar “pawn” 
icon and to send instant messages or e-mail to team members. This pane brings the 
collaboration of tools right into the user’s document environment. 

Document Workspaces 
When working with others on a document, users often start by sending the document to 
their co-workers through e-mail. When the document is in a single server location, users 
often need to have an offline or local copy of the file as well, because they are off the 
network occasionally or because the server copy is locked for editing by another user.  

Using e-mail and having offline copies always results in documents getting out of sync, 
or “forked” into multiple incarnations. The various versions that result often require 
lengthy reconciliation. When using e-mail, it is also difficult to track the other 
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contributors' progress. This situation becomes exponentially more difficult as the 
number of contributors increases. 

Document workspace sites make ad hoc, everyday document collaborations and team 
projects easier in several ways. As with any SharePoint site, they centralize all of the 
“artifacts” of collaboration: task lists, deadlines, related documents, hyperlinks, and 
contacts for participants. They also integrate with Office 2003 Editions programs 
through the Shared Workspace task pane that is directly next to the document itself in 
the program, allowing for easy access to all of these resources and bringing the team-
collaboration context into each worker’s personal productivity tools. Unlike e-mail, 
where the original authors have no way of knowing whether the people who they have 
been asked to contribute have even started working, the Shared Workspace task pane 
and Document Workspace sites allow each user to view the incremental progress of task 
completion. 

Actions that the Document Workspace supports include the following: 

• Collaborating with other team members while increasing productivity time 
• Safeguarding against multiple versions of a document by creating a master copy 

and subsequent versions 
• Tracking a document’s progress through other team member’s productivity 

without setting up a server 
• Synchronizing a document stored locally with the master copy 
• Creating a new Document Workspace 
• Manipulating other team members' work 
 

Creating a Document Workspace through an Office program 

Users can create a Document Workspace in one of two ways. On the Tools menu, the 
user can select the Shared Workspace menu item, or the user can open the Shared 
Workspace task pane directly to create a Document Workspace site for any Office 
document on the hard drive. This document then becomes a connected local copy of 
the document, with a master copy on the server. Users can solicit other contributors, 
add links, and more without ever leaving the program in which they are working. 
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Creating a Document Workspace for a document in a SharePoint site 

Sometimes SharePoint sites can grow quite large with many documents and members. 
In such cases, some users may want to take a specific document to a semi-private space 
to work on it further, without disrupting the current, “public” version. Users can create 
a Document Workspace site for the document to work on it alone or with a few others 
until it is finished, and then republish it to the main SharePoint site. 

 
Any document in a SharePoint site can reside in a Document Workspace site that has been 
created for it and that has limited membership. When changes to the document are complete, 
the author can “publish back” to the original location and update the original document so that 
everyone can see the changes. 
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Working in a Document Workspace 

In Outlook 2003, when users attach an Office document to an e-mail message, they see 
the Attachment Options task pane. By default, the attachments are sent as they were in 
the past. However, if the users select the “Shared Attachment” option, the sent 
document is stored on a Document Workspace site that is created automatically on an 
available server running WSS. If they want to, the users can specify the SharePoint site 
on which to create the Document Workspace, or can accept the default choice.  

 
An e-mail message in Outlook with the Attachment Options task pane visible and shared 
attachments selected. Simply sending the attachment through e-mail brings up the Attachment 
Options task pane. 

Whether initiated through e-mail messages or Office 2003 programs, sharing 
attachments automatically provides all of the collaborative workflow and information 
functionality of the Document Workspace. This information also appears in context, 
directly in the Shared Workspace task pane and next to the document when any 
teammate opens it on a PC. Anyone who receives the e-mail is automatically added to 
the workspace. By sending a simple e-mail and an attachment, the users have initiated a 
powerful collaboration tool for their team of co-workers, wherever the individual team 
members might be. 

Every recipient of the original e-mail receives both the soft copy of the attachment and 
a link pointing to the Document Workspace site where the latest copies of the 
document can be found. Each recipient also receives other information that is related to 
the collaboration. Recipients who do not have an Office 2003 Edition can either work on 
the out-of-date attachments as they would typically, or use the included link to the 
Document Workspace site to see the most up-to-date information.  
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Users can work directly off the server while online. Recipients who have an Office 2003 
Edition see an added benefit: any Office documents that were attached to the e-mail are 
automatically connected to the master copies in the Document Workspace site. When 
those documents are opened, the program offers to check for an updated version on 
the server. The out-of-date e-mail attachment remains attached to the e-mail and is 
simply ignored by the program when it opens the updated version. 

When a recipient opens the attached document, the Shared Workspace task pane 
appears, providing information about the Document Workspace. Because the shared 
attachment is on the user’s local machine, it can be edited offline or online, even if 
other users are working on the server copy or on their own connected local copies. The 
Office 2003 Editions user can work on the most current version and cannot be 
inadvertently locked out by others who might be using the server copy of the document. 
From this point onward, Office 2003 Editions users no longer have to distribute e-mail 
copies of the document with incremental revisions, which helps to eliminate confusion 
and saves network storage space and bandwidth. 

When an attachment is shared in a Document Workspace site, each co-author is 
prompted when others have made changes to the document and is given the 
opportunity to review the changes or to contribute additional changes in real time. 
Using SharePoint Tasks and Alerts, teammates can also track other contributors' 
progress.  

When working online in a Document Workspace site, instant messaging integration also 
makes it easy to see when other authors are online and to initiate conversations with 
them. Instant messaging is enabled even if the user chooses to work offline. 
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Users can also use these functions from the SharePoint Web site that hosts the Shared 
Workspace, either directly from the Shared Workspace task pane or by navigating to it from a 
Web browser 

Integrated Web discussions 
WSS enhances the existing shared editing features in Office 2003 Editions by providing 
inline discussion tools and by storing inline discussion comments on the SharePoint site. 
This means that reviewers can add their comments directly to the document and that 
reviewer comments are stored and managed centrally, so they are available whenever 
an editor or reviewer opens a document from the SharePoint site. To make changes to a 
document in a SharePoint library, the user must be a member of a site group with the 
Edit Items right for that SharePoint site. 

Meeting Workspaces 
Meetings Workspaces are for anyone who invests time in preparing for, conducting, and 
following-up on meetings. The workspace provides a secure online site to centralize all 
meeting-related communication, documents, and logistics, making it the perfect 
location for everything that is related to the meeting and that needs to be organized, 
shared, and archived. The Meetings Workspace is designed to make the meeting 
process more intuitive, streamlined, and effective, saving customers time and improving 
meeting productivity. 

Because it has been built using WSS and Web Parts, the Meetings Workspace is 
essentially a customized site that provides simple, intuitive tools that help bring 
together employees for one-time, recurring or related meetings.  

With Meetings Workspaces, meeting coordinators can easily plan the meeting; 
coordinate attendees; provide any necessary documents or collateral in the meeting 
area; loop in remote employees; capture the information, tasks, and follow up items 
that are generated during the meeting; and disseminate meeting notes and action 
items. 
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By creating a Meetings Workspace, meeting coordinators can easily plan and conduct meetings, 
and keep track of follow-up items. 
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Actions that the Meetings Workspace supports include the following: 

• Disseminating pre-planned agenda items and materials  
• Sharing visuals, content, meeting minutes, action items  
• Facilitating recurring meetings  
• Reporting problems with a current meeting’s time or location 
• Updating collateral without having to resend the meeting request 
• Taking simple notes during the meeting or capturing more complex notes from 

OneNote, for example 
• Connecting mobile or remote users to the meeting 
• Integrating meetings calendar views in a SharePoint list  
• Creating, provisioning, and managing a Workspace site 
• Integrating Workspace with any SharePoint site 
• Relating Workspace information through program task panes 
• Editing Workspace data by using Excel 2003, PowerPoint 2003, and Word 2003 
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Creating and customizing a Meeting Workspace  

Before a Meeting Workspace site can be created, a meeting request must be opened. 
This meeting request can either be a new or an existing request. If the meeting request 
is new, the meeting attendees must be chosen before a Meeting Workspace can be 
created. 

Use the Meeting Workspace task pane in Outlook 2003 to set up a Workspace. After 
opening a new or existing meeting request, the user clicks the Meeting Workspace 
button to open the Meeting Workspace task pane. In the Meeting Workspace task pane, 
the user can link an existing Meeting Workspace to the open meeting request, 
customize the settings for the existing Meeting Workspace, or create a new Meeting 
Workspace. The user can customize the Meeting Workspace settings quickly and easily 
by making selections in the task pane. 

 
The Meetings Workspace provides a consolidated area for scheduling, disseminating to 
participants, and keeping track of results. Web Parts can be added easily to provide other streams 
of information. 
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File Menu integration 
Document sharing is fully integrated into the File menu in most Office 2003 Edition 
programs. Using the File menu to open or save documents in a document library, a 
document repository on a SharePoint site. When you save a document in a document 
library, Office 2003 Edition programs also store metadata for the document in the 
library. When you close the document, you may be prompted to add or update 
metadata. 

 
Saving a document in the document library allows for efficient document sharing. 
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Version tracking 
WSS also handles version tracking for Office 2003 Editions and other Office documents 
stored on a SharePoint site. WSS keeps copies of previous versions of each document. 
Users can go back and view the changes that were made to a document at any time. 
This is particularly useful when rolling back a document to a previous version or when 
retrieving data that was deleted from an earlier version of a document. To turn version 
tracking on or off, a user must be a member of a site group with the Manage Lists right 
for that SharePoint site. 

 
The document library shows the versions of a document saved. Users can view or retrieve 
information from any of these versions. 
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Document Check-in and Check-out 
Most traditional document sharing methods use e-mail or file shares for documents that 
have multiple authors or editors. The problem with these methods is that they can 
quickly become confusing. Identifying the latest version of a document is difficult, and 
multiple users may edit a document at the same time, resulting in conflicting versions. 
Trying to track changes can lead to confusion and lost productivity, especially if a 
document must be rolled back to an earlier version. 

To prevent these problems, WSS provides an intuitive, easy-to-use method for tracking 
the version history of a document. First, an Office 2003 Editions or other Office 
document that is stored in a document library can be checked out. When this is done, 
other users cannot make changes to the document. This helps prevent the confusion 
that can occur when multiple users make simultaneous changes to the same document. 
Documents can then be checked in so other users can work on them. To check out a 
document, the user must be a member of a site group with the Edit Items right for that 
SharePoint site. 

 
Documents can be checked into the document library so other users can work on them. 
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Windows SharePoint Services integration with Office 2003 
Editions programs 
The integration of Office 2003 Editions programs and WSS offers users tools that are powerful 
and easy to use and that make collaboration easier. A WSS site provides a virtual community for 
team collaboration—making it easy for users to work together on documents, projects, events, 
and other activities where information sharing is essential. 

In addition to the new Workspaces, Outlook 2003 offers a workgroup server, offline availability, 
and multiple calendar views and lists. Microsoft Office Access 2003 has features that allow users 
to link tables to other SharePoint Web sites and preserve full read/write capabilities. Because 
Excel 2003 and the various SharePoint lists are integrated more closely, a user can import or 
export a list to or from Excel and share it with other team members. The Office 2003 Editions 
program and WSS integration gives users more opportunities for increased accessibility to view, 
edit, read, or write information within Outlook, Access, and Excel. 

Windows SharePoint Services and Outlook 2003 
With Office 2003 Editions, data from WSS can be used from directly within Outlook, 
allowing users to make better use of team information by integrating it with their own. 
Outlook 2003 provides users with team calendars to centralize team-specific 
appointments, specialized alerts to notify team members about any changes made to 
shared documents, and other benefits, such as workgroup servers, offline availability, 
and SharePoint capabilities. 

Team calendars 

Team calendars allow teams to post their schedules of product reviews on a SharePoint 
site for the whole team to reference. Team members can check that schedule against 
their own by opening up the live calendar view of a SharePoint list side-by-side with 
their individual Outlook calendars. Events from a SharePoint list look and act just like 
Outlook appointments and can be dragged and dropped from the SharePoint calendar 
into each user’s Outlook calendar. 

Specialized alerts 

Specialized alerts can help workers to be more effective by providing relevant 
information that keeps them up to date. Users can view alerts by clicking Alert Me links 
in any SharePoint Web site, or by selecting Rules and Alerts from the Tools menu in 
Outlook, and then clicking the Manage Alerts tab. 
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Alerts can be used to notify users of changes to documents, list items, document 
libraries, lists, surveys, or even search results by sending e-mail notifications. In 
addition, users can easily set up rules to move alert e-mails to folders and can view all 
active alerts in Outlook by using the Rules and Alerts dialog box. From there, users can 
delete the alert, jump directly to the Web site, create rules to act on the alerts, and 
more. 

 
By selecting the options that best meet their needs, users can customize the alerts they receive 
and stay up-to-date on the status of a shared document. 

Other benefits 

Other benefits of tight integration between WSS and Outlook 2003 include the 
following: 

• Workgroup server. Small businesses can use WSS as a small workgroup server 
that enables shared contacts and calendars without having an Exchange server. 

• Offline availability. Data from WSS is cached on the local computer so that it 
can be taken offline. These calendar and contact lists can be viewed even when 
the SharePoint site is unavailable, such as when the user is on an airplane. 

• SharePoint in Outlook 2003. Outlook users can open calendar lists, event lists, 
and contact lists within the Outlook user interface as a read-only source of data. 
The data from WSS looks and acts just like native Outlook calendars and contact 
lists, and calendars can be opened side-by-side. 
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Shared Lists 
Users of WSS benefit from the enhanced ability of Office 2003 Editions to work with 
SharePoint lists. Each enhancement to the list experience in WSS enables a range of 
scenarios not previously available. The enhancements also provide the ability to 
combine SharePoint lists with the rich functionality of core Office programs, opening 
new possibilities for collaboration, data collection, and analysis.  

• New! Grid view. This new view style is similar to the grid display style in 
Excel 2003, and brings Excel-like functionality to WSS with functions such as 
calculation formulas, AutoFill, AutoComplete, Sorting, and Filtering. 

• New! Multiple-user list collaboration. Multiple users can now edit the same list 
at the same time. WSS detects any conflicts, and then presents conflict-
resolution options. 

• Improved! Easy editing. Users can drag and drop to rearrange rows and 
columns or move data inside a list. 

• Improved! Office program integration. Users can now have the best of both 
worlds, using Office programs to work with SharePoint lists. By using Excel 2003, 
for example, users can print lists, take lists offline, and create tables or charts 
with list data. 

• New lists. New lists include Photo Library, which offers options for storing and 
viewing pictures, and Business Document Libraries, which enable XML solution 
authoring, editing, and storage in the team site. 

• Improved lists. Improvements to the existing lists include options for scheduling 
reoccurring meetings in event lists, and new security settings that allow 
delegation of permissions to a per-list level. 

Windows SharePoint Services and Excel 2003 and Access 2003 
WSS provides Office 2003 Editions users multiple ways to manipulate data in lists and 
tables created in Excel 2003 and Access 2003. Lists that reside on SharePoint sites can 
be synchronized using Excel 2003 and Access 2003. Both programs have individual 
benefits for users as well. Users can easily update WSS lists in Excel 2003. Users can now 
create a table in Access 2003 and link it to lists that reside on a SharePoint Web site 
while maintaining full read/write capabilities.  

List synchronization 

Microsoft Office Excel 2003 and Microsoft Office Access 2003 can now be used to view 
and edit data stored in lists on SharePoint sites. This is an excellent way to share 
information with other users, make use of information that is already published, and 
provide standardized lists of information (for example, product names or company 
departments) that can be used throughout the company. 
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Updating Windows SharePoint Services lists in Excel 2003  

Office 2003 Editions make it easy for users to view, edit, and update WSS lists in Excel. 
Excel 2003 now offers the ability to share ranges that are designated as lists by 
exporting them as a SharePoint list. Users can also import SharePoint lists into Excel, or 
link to them so that changes to the list are shared between the server and the Excel 
client.  

The SharePoint Datasheet List Control, which is similar to the grid display style in Excel, 
makes an Excel-like editing experience available in a browser so that content can be 
edited in WSS through Datasheet Control. 

Conflict resolution is also provided when lists are updated from Excel 2003, and lists can 
be modified offline by using Binary File Format (BIFF). XML tags that map to items on 
existing Excel business forms can also be created, such as “employee name,” “amount,” 
or “quantity,” making those forms another easy-to-use data warehouse.  

The new Spreadsheet Web Component in WSS can consume any Excel spreadsheet that 
is mapped to an XML schema, and can provide that data to both SharePoint and non-
SharePoint data sources. The component displays data according to a mapping of XML 
elements.  

Linked tables between Access 2003 and Windows SharePoint Services  

Users can now link tables that were created in Access 2003 to lists on SharePoint Web 
sites and maintain full read/write capabilities. Users specify that they want to use 
SharePoint as the type, and then they select the Web site and the list name. 

This means that WSS can act as a new type of database server for Access 2003 users 
who want to collaborate with others across the Web and use the familiar desktop 
program interface, or who want to incorporate SharePoint data into other tracking 
projects that they already perform.  

The following table shows WSS integration features for each program in Office 2003 
Editions: 

Windows SharePoint Site Feature Office 2003 Edition Programs 

Open and Save from File menu Excel, Outlook, PowerPoint, Publisher, Word 

Shared Workspace task pane Excel, PowerPoint, Word 

Create shared attachment Outlook 

Synchronize calendar and contact list sites Outlook 

Document updates for shared attachments Excel, PowerPoint, Word 

Automatically collect metadata Word, Excel, PowerPoint 

Check-in / check-out Word, Excel, PowerPoint 

Version Tracking Word, Excel, PowerPoint 

Store inline discussions on the server Word, Excel, PowerPoint 

Import SharePoint list as data Excel, Access 

Export data as SharePoint list Excel, Access 
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Manage team time 
One of the ways to make a project successful is to ensure that all team members stay current 
with personal and team schedules. The Office 2003 programs and WSS integration offer users 
instant messaging capabilities while working within Outlook 2003 or with a document. Team 
members can also view personal and team calendars and contacts side-by-side, so scheduling 
meetings and tracking down references is more efficient. 

Instant messaging integration and presence integration 
Instant Messaging (IM) technology is integrated with Office 2003 programs to provide 
instantaneous presence information and the ability to initiate conversations quickly 
from within documents or Outlook. 

Team calendar views 
When a user is viewing multiple calendars, correlations between appointments can be 
difficult to understand. Outlook 2003 offers color-coded team appointments within each 
team member’s calendar so that the user can distinguish between team appointments 
and other appointments. 

Accessing the side-by-side calendars in Outlook 2003 

Outlook 2003 makes it possible to view multiple calendars—including local calendars, 
public-folder calendars, other users’ calendars, and calendar views—side-by-side in the 
Outlook window. The color-coded calendars scroll together, making them useful for 
comparing schedules or finding a teammate. Users can drag appointments between 
calendars or onto their own calendar, or use the New Meeting With feature to set up a 
meeting quickly with the owners of some or all of the open calendars. 
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After a user has opened a calendar, it appears in the Calendar module of the Navigation 
Pane. To turn these calendars on side-by-side, the user simply selects the box next to 
the appropriate calendars. To turn a calendar off, the user simply clears the box. 

 
The side-by-side calendars view in Outlook. At left the Navigation Pane shows the calendars that 
the user has access to. To use the New Meeting With function, open several calendars side-by-
side. Right-click the calendar and highlight “New Meeting With.” 
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Accessing integrated contacts and calendar information from Windows 
SharePoint Services in Outlook 

Contacts and Calendars are common lists that store both personal and group 
information. Outlook 2003 and WSS now allow users to view team and personal 
calendars side by side. The user can select to view the team calendar and the team 
contacts directly in Outlook, making the information always available.  
 

 
To view a calendar list from WSS in Outlook, navigate to that calendar by using the Web browser. 
Click the “Link to Calendar” button in the toolbar. Outlook will ask you to confirm that you want 
to add the calendar: Click “Yes.” 
 
After a calendar from WSS has been added, it can be opened in Outlook 2003 and 
compared with the user’s default calendar that appears in Outlook. 
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If you are opening a calendar, the calendar list is opened up side-by-side with your default 
calendar and added to the “Other Calendars” list. Contacts lists can be viewed in Outlook in the 
same way.  

Helping to Protect Sensitive Documents 
New technologies in Microsoft Office 2003 Editions help protect digital intellectual property. 
Information Rights Management (IRM) in Office 2003 Professional allows functions such as cut, 
copy, paste, print, and e-mail forwarding to be restricted for specific documents and e-mails, 
giving users and organizations more control over their valuable information assets. With Word 
2003, in-document editing rights and style protection allow document owners to specify who is 
allowed to make changes. 

Information Rights Management in Office 2003 Editions 
IRM is a new policy enforcement technology in Office 2003 Editions that helps protect 
documents and e-mails from unauthorized access and use.  IRM is a persistent, file-level 
protection technology that allows the owner to specify who can access a document or e-
mail and control whether those users are allowed to edit, copy, forward, or print the 
contents.  IRM is an extension of Windows Rights Management Services (RMS) into 
Microsoft Office 2003 programs. IRM in Office Professional 2003 Edition requires RMS 
on Windows Server 2003, either within the organization or via a service such as 
Microsoft Passport.  Windows Rights Management Services for Windows Server 2003 is 
a new premium service that requires a separate Client Access License (CAL). 

IRM is a policy enforcement technology, not a security technology, allowing documents 
and e-mails to be distributed while helping to maintain control over who can access 
content and how they can use it. Once a document or e-mail is protected with this 
technology, the access and usage restrictions are enforced no matter where the file or 
e-mail goes.  

IRM support in Microsoft Office 2003 Editions helps corporations and knowledge 
workers address two fundamental needs:  

• Helping to protecting digital intellectual property. Most corporations today rely 
on firewalls, login security, and other network technologies to protect their 
digital intellectual property. The fundamental limitation of these technologies is 
that, after legitimate users have access to the information, the information can 
be intentionally or accidentally shared with unauthorized people, creating a 
potential breach in security policies. IRM helps protect the information itself 
from unauthorized access and reuse. 

• Helping to ensure information privacy, control, and integrity Knowledge 
workers often deal with confidential or sensitive information, relying on the 
discretion of others to keep sensitive materials in-house. IRM helps eliminate 
the risk of accidental leaks by disabling the forward, paste, or print functions in 
IRM-protected documents and e-mails.  In addition, IRM can enforce expiration 
dates to help ensure that knowledge workers only see and use up-to-date 
content. 
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For IT managers, IRM helps enforce enterprise policies regarding document 
confidentiality, workflow, and e-mail retention. For CEOs and security officers, it helps 
reduce the risk of having key company information get into the hands of the wrong 
people, whether by accident, thoughtlessness, or malicious intent.  

When enabled by the organization, users of Office 2003 Editions will be able to easily 
take advantage of this technology.  To create and protect documents and e-mails with 
IRM, Microsoft Office Professional Edition or the full stand-alone products are required.  
A simple user interface based on customizable “rights templates” available in the 
standard toolbar makes IRM convenient and easy to use.  Other Microsoft Office 2003 
Editions will give users the ability to read and edit IRM-protected content, but not 
create.  Integration with Active Directory® provides a level of convenience not seen on 
today’s document-specific passwords.  

Finally, IRM-protected documents and e-mail can be shared across organizations and 
with users that do not have Office 2003 Editions. Microsoft is offering, for a limited 
time, an IRM service for customers who do not host their own Windows Rights 
Management Services Server. The Rights Management Add-on for Internet Explorer 
allows any Microsoft Windows user to consume IRM-protected documents whether or 
not they have Office 2003 Editions.  This service will use Microsoft Passport as the 
authentication mechanism instead of Active Directory.  Users of this service will not be 
able to create custom rights templates, such as the “Company Confidential” template 
described earlier, but they will be able to share and access IRM-protected documents 
and e-mails. 

 

How and when to enable IRM in Outlook 2003 

IRM in Outlook 2003 helps prevent unauthorized forwarding, copying, or printing of 
sensitive e-mails. It also helps to protect messages that are automatically encrypted 
during transit, and when the sender applies usage restrictions, Outlook 2003 disables 
the necessary commands. Office documents that are attached to protected messages 
are automatically protected as well and these policies persist with the document. 
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Users can apply usage restrictions to limit who can read and change e-mail messages and 
attachments. 

Leveraging IRM in Excel 2003, Word 2003, and PowerPoint 2003  

IRM in Microsoft Office Professional Edition 2003 allows the document owner to assign 
permissions to individual users and groups (groups based on Active Directory). In 
Excel 2003, Word 2003, and PowerPoint 2003, each user or group can be given a set of 
permissions according to the following roles: read, change, and full control. Depending 
on the recipient’s role, IRM disables certain commands to enforce the rights that are 
assigned. The document owner can also prevent printing and can set expiration dates. 
After expiration, documents cannot be opened. 
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Users can apply usage restrictions to limit who can read, change, or control Excel 2003, 
Word 2003, and PowerPoint 2003 files. 

Permission options  
If a protected document is forwarded to an unauthorized recipient, the document 
cannot be opened and an error message that contains the document owner’s e-mail 
appears so that the recipient can request additional rights. If the document owner 
decides not to include an e-mail address, unauthorized recipients simply get an error 
message.  

Organizational policies and template options 

On the Windows Rights Management Server, organizations can create “rights 
templates” that will appear in Office Professional Edition 2003 programs. For example, a 
company might define a template called “Company Confidential,” which specifies that a 
document or e-mail in that template can only be opened by users inside the company 
domain. These templates can reflect the policies of the organization, and the number of 
templates that can be created is unlimited.  



 

 
 
 

38 

Rights Management Add-on for Internet Explorer 

Because enforcement of rights is done at the application level, Office files protected 
with IRM technology can only be opened and edited by Office 2003 Editions. However, 
Rights Management Add-on for Internet Explorer allows users without Office 2003 
Editions to read IRM-protected materials. The Rights Management Add-on for Internet 
Explorer is available for download free of charge at www.microsoft.com (connect-time 
charges may apply). 

The Rights Management Add-on for Internet Explorer will play an important role in 
communication between business units and with business partners, as companies may 
choose to migrate to Office 2003 Editions on their own timeframes. Companies can use 
IRM in Office 2003 Editions knowing that authorized users will be able to access and 
consume protected content, even if they do not have Office 2003 Editions. 

Additional server requirements 
Microsoft Windows Server™ 2003 with Rights Management Services and Active 
Directory are required to enable IRM fully in Office Professional Edition 2003. The Rights 
Management Services feature requires a premium Client Access License (CAL). Microsoft 
is also hosting, for a limited time, an IRM service through Passport for customers who 
do not have the Windows Server 2003. This service will enable users to share protected 
documents and e-mail by using Microsoft Passport as the authentication mechanism. 

Note that users of Office Standard Edition 2003, Office Small Business Edition 2003 and 
Office Student and Teacher Edition 2003 cannot create new IRM-protected documents 
or e-mail messages, or modify the permissions on existing IRM-protected files. However, 
they can open, edit, save, and print IRM-protected documents and e-mail messages with 
the appropriate permissions. 

Regional Permissions 
When teams collaborate on very large documents, some users may be assigned certain 
portions of the document to work on. In the past there was no way to ensure that each 
user only modified the assigned portion of the document. When it came time to 
reconcile the edits and merge changes into a master document, large numbers of 
conflicting edits often caused problems. 

Document owners can set permissions to certain regions or specific portions of a 
document from being editing by some or all users. Using the Protect Document task 
pane (by selecting the “Tools” menu, and then “Protect Document”), a document owner 
can first protect the whole document against any edits (optionally allowing only 
comments), and then assign permissions to individual portions of the document by 
selecting them and specifying the users who should be able to edit that selected region. 
Later, when reconciling the changes of different individuals, the document owner is 
assured that no two people edited the same area, and no conflicts will exist. 
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After the permissions have been set up, the task pane switches focus from helping the 
creator set up the permissions and manage the list of users to helping users find the 
parts of a document that they can edit.  

 
User view of the Protect Document task pane  

Structured Editing in Word 2003 
Word 2003 includes additional features to allow a large number of users to collaborate 
on a large, sophisticated document in a structured way. 

Formatting Restrictions 

Many large organizations need to produce documents that show a consistent style or 
appearance. Although this can be accomplished with Word styles, many users are not 
familiar with how styles function, and so they resort to formatting the document 
directly. Over time, large documents that include direct formatting become a burden to 
maintain because updating the styles does not change the appearance of the document, 
and moving portions of a document to another document does not produce the 
expected result.  
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With Word 2003, users can set up a template or a document that uses a set of specific 
styles. By using the Formatting Restrictions feature of Word 2003, the user can enforce 
the use of only those specified styles. All direct formatting is disabled. This allows many 
people to edit the same complex document and still retain structured formatting.  

 
Creator View of the Protect Document task pane 

 

Summary 
The Office 2003 Editions and WSS integration make it easier and more efficient for users to 
connect with other team members and the information that they need. By enhancing the 
desktop programs that employees are already familiar with, the Office 2003 Editions help users 
spend their time making progress on their projects instead of learning a new set of features and 
commands. The Professional version of Office 2003 Editions also allows authors to create 
documents and e-mail messages that are better protected from unauthorized use by offering 
IRM technology. This improved functionality in the Office 2003 Editions assists users when 
working on projects that require team efforts. 



3 Connect Information  
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Introduction 
Often, too much information exists, in too many places, for workers to keep track of it. Tasks 
such as organizing and managing e-mail can often take much of the workday; the process of 
accessing e-mail slows the process further for remote and mobile users. Junk e-mail has become 
increasingly problematic because it can consume valuable space and prevents efficient 
processing of important e-mail. 

Given this influx of e-mail and other data, locating information often requires going to multiple 
locations. Microsoft® Office 2003 Editions provide new ways to help workers stay organized and 
manage the details that accompany information overload. 

Organizational and design enhancements 
The redesigned look and feel of the Office 2003 Editions helps users manage and 
prioritize large volumes of information. The simplified interface of Microsoft Office 
Outlook® 2003, ink support for the Microsoft Tablet PC, and more make it easier to 
read, organize, and work with information. Some new design enhancements to 
Outlook 2003 include allowing users to read e-mail more quickly by using the new 
Reading Pane, to find important messages by using Search Folders, and to view tasks at-
a-glance by using Quick Flags.  

New feature highlights 
With the improvements and new features of Outlook 2003, users can manage large 
volumes of information quickly and easily. The new screen layout optimizes screen 
space while giving users a comprehensive look at their Inbox, and users can organize 
messages virtually in Search Folders—by using the built in search folders or creating 
their own. Quick Flags let users mark e-mail messages that require follow-up action and 
these messages are easily found in the new For Follow Up search folder.  

New security settings offer increased support for junk e-mail filtering and blocking of 
external content. Remote and mobile users can take advantage of improvements to 
connectivity performance with better caching. Along with a new look, Office 2003 
Editions users can draw information from a variety of locations quickly by using the 
Research task pane. 
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A new look for Outlook 2003 
Microsoft Office Outlook 2003 provides innovative features that help users manage and 
organize e-mail messages, contacts, calendar tasks, notes, and other critical information. The 
new look for Outlook 2003 helps users organize information to increase productivity and get the 
information they need. Outlook 2003 also helps users block the information they don’t need and 
protect against the misuse and unwanted distribution of key company information.  

Working with new e-mail views 
Studies of Outlook users show overwhelmingly that the sender’s name or address is the 
most important criteria that is considered when deciding whether to open e-mail 
messages. The Multi-line view puts the sender’s name in dark text in the upper-left 
corner, making it easy to scan down the list for important names. Secondary 
information is rendered in lighter shades of text to draw the eye towards the more 
important information. This Multi-line view also provides a taller region, which makes 
messages easier to select with the pen on a Tablet PC. 

Microsoft has listened how customers interact with their e-mail. In the Office 2003 
Editions, Outlook 2003 features a new interface that breaks from the traditional mold.  

The new interface uses the Reading Pane (described below) to create a very efficient 
and easy-to-use layout of messages on the screen. The vertical column orientation of 
the new layout makes it possible to see nearly twice as much data on the screen at 
once. The new e-mail view is also optimized to help users easily find items and navigate 
through t e-mail. This efficient layout means less time spent scrolling and more time 
accomplishing work. 

Reading Pane 

The Reading Pane helps reduce eyestrain and makes time spent reading e-mail more 
efficient by showing more of the message on the screen. This reduces scrolling and 
often eliminates the need to open and manage many separate windows for different 
messages. 
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Replacing the Preview Pane from previous versions of Outlook, the vertical layout of the 
Reading Pane presents messages in a manner that is more consistent with the way 
newspapers have been formatting text for hundreds of years. This simple redesign, in 
addition to the new multi-line mail list, frees up nearly twice as much monitor space for 
text as the previous horizontal view Preview Pane, and makes for a more comfortable 
reading experience overall. 

 
The Reading Pane is on by default in Outlook 2003. The Reading Pane accommodates more than 
three paragraphs of text and 14 e-mail messages, whereas the Preview Pane in earlier versions of 
Outlook showed only two paragraphs of text and 11 e-mail messages. 

Intelligent grouping 

When creating lists, users naturally group similar items together, such as a to-do list 
under the headings “Today,” “Tomorrow,” and “Next Week.” The new e-mail view 
automatically applies intelligent groupings to help users sort messages.   

For example, when users arrange mail by the date it was received, Outlook 2003 splits 
the communications into simple groups—“Today,” “Yesterday,” “Last Week,” “Last 
Month,” and so on. When users rearrange by size, Outlook 2003 again splits the 
communications into user-friendly groups—“Large,” “Small,” “Very Large,” and so on. 
These groups make it easier for users to scan through a list and find what they need, 
because the groupings reflect the way most humans work.  
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Advanced users can treat these groups as objects, choosing to move, delete, copy, 
forward, or perform other actions on all items in the group at the same time. For 
example, e-mail messages could be grouped by date, and then all messages from “Last 
Month” could be dragged to another folder and filed away with one click. 

 
Clicking the Arrange By button shows the list of possible arrangements, such as by Date, From, 
Subject, Size, Flag, and so on. This menu is also available by clicking View -> Arrange By. 

Smart Dates 

To use space more efficiently in the Multi-line view, Smart Dates change the date format 
on the fly based on how long ago the message was received. For example, an e-mail 
message that was received today will only display a time: 3:40 p.m. Messages that were 
received during the current week display a day of the week and time: Wed 1:24 a.m. For 
e-mail that was received many months ago, the exact time is less important, so 
Outlook 2003 displays only the date: 1/12/2003. This makes it easier for the user to sort, 
find, file, and manage e-mail quickly and efficiently. 
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Arrange by Conversation 

Arrange by Conversation helps with the most common task that is performed in 
Outlook: reading mail. It was designed to help users quickly catch up on their e-mail, 
without embarrassing themselves by replying to items that have already been resolved.  

Arrange by Conversation displays e-mail messages in a conversation-oriented or 
“threaded” view, by default showing only e-mail that is unread or marked for follow-up, 
so the user doesn’t need to skip over dozens of read messages to find the new ones. 
Similar messages are grouped together, and indentation shows clearly who responded 
to whom throughout the conversation.  

Each conversation can be expanded to show all related messages, so users can easily 
view the entire conversation at once, instead of reading pieces here and there. A user 
can use Arrange by Conversation just as easily as sorting mail and by using the same 
interface, which means that the feature can be used right away by anyone who is 
familiar with Outlook. And because multiple messages in a conversation share the same 
subject, the subject line only needs to be shown on the screen once per conversation, 
allowing for as many as twice the number of messages to fit on the screen. As with any 
group in Outlook, the conversation can be treated as an object, meaning that users can 
delete, copy, file, or forward the entire conversation at once. 

 
In the Arranged by Conversation view, messages about the same conversation are grouped 
together and indentation shows who replied to whom. Only unread and Quick Flagged messages 
are shown by default, so the screen remains uncluttered while the user catches up on e-mail. 
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To arrange new messages by conversation, click Arranged By over the new mail view, 
and then click Conversation. Or, click Arrange By on the View menu, and then click 
Conversation.  

Navigation Pane 
The Navigation Pane builds more efficiency into Outlook 2003 by combining the main 
navigation and sharing aspects of the program into one easy-to-use pane. With the 
Navigation Pane, users experience more relevant and context-sensitive navigation 
through Outlook 2003, rather than a simple, static list of folders. 

In Calendar, for example, users see the date navigator and other users’ shared 
calendars. In Contacts, users get a list of all contacts folders they can open, both local 
and shared, in addition to different ways to view the contacts. The Navigation Pane is on 
by default. To turn it off and on, click View, and then click Navigation Pane. 

The Navigation Pane improves Outlook 2003 in several ways: 

• Efficient use of screen space The best of the Outlook Bar and the Folder List are 
brought together into a smaller, more efficient space. All navigation options, not 
just folder navigation, are in one place, giving users dramatically increased space 
to view their data. For example, users can view up to twice as much of their 
Calendar in Outlook 2003 compared to Outlook 2002. 

• Context sensitivity. Simplified, context-sensitive navigation shows the most 
relevant information for each type area of Outlook. For instance, in the Mail 
pane, users view the list of e-mail folders and search folders. In Calendar, they 
see a date picker and a list of calendars that are available to them. 

• Shared data. Sharing information is simplified by presenting shared data next to 
a user’s own data. For example, users can view other calendars to which they 
have access, placing them side-by-side with their own calendar. 

• View settings. View settings appear in the Navigation Pane, making it easy to 
change how something is displayed. 

• Quick Launch. Advanced users appreciate the ability to shrink the module 
buttons into a Quick Launch bar to save space. 

• Go menu. The Go menu and associated keyboard shortcuts make the Navigation 
Pane more accessible. 
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Navigation Pane with large buttons Navigation Pane with smaller buttons 

The Navigation Pane. The splitter between the big buttons at the bottom and the content pane 
can be moved up and down to create larger or smaller buttons. The large buttons are great for 
easy clicking with Tablet PC or other pen-based computers, or users may choose to shrink all the 
buttons to a single Quick Launch bar in order to save space. 
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Navigation Pane modules 

Each of the eight Navigation Pane modules has a unique but consistent user interface 
that presents the most relevant information in an efficient space. The following eight 
Navigation Pane modules are available. 

Mail view 

The Mail pane displays e-mail folders and Search Folders, and also includes a Favorite 
Folders section at the top for quick access. To create favorites, users simply drag an e-
mail folder or Search Folder to the Favorite Folders area. 

 
The Navigation Pane in Mail view. By default, four large buttons appear at the bottom, with three 
buttons minimized to the “Quick Launch” state. The section at the top, Favorite Folders, can 
include any folders that you want to keep handy for quick reference—just drag them to the 
Favorites section. 
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Calendar view 

The Calendar pane shows the date navigator at the top, and under that the list of all 
calendars to which the user has access, including local calendars, Microsoft Windows® 
SharePoint Services™ calendars, public folder calendars, and other users’ calendars—all 
in one simple list. Calendars can be individually turned on or off to view them side-by-
side in the Outlook window. Links are also available to open shared calendars and to 
share the user’s own calendar (or modify permissions). 

 
Through the Calendar view, all local, shared, and team calendars are simplified to a single list, 
regardless of location.  
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Contacts view 

Like the Calendar pane, the Contacts pane displays all contacts to which the user has 
access—including local contacts, Windows SharePoint Services contacts, public folder 
contacts, and other users’ contacts. Users can opt to view contacts in different ways, 
such as “By Company” or “Address Cards,” in addition to any custom views they have 
created. Links are also available to open shared contacts, share contact information, 
modify permissions, or modify the options of the Current View. 

 
In the Contacts view, all contacts folders that the user can open, including local, public and 
shared, are presented in a simple list. The Current View section provides an easy way for users to 
arrange contacts. 
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Tasks view 

The Tasks pane shows a list of all tasks folders that the user can open, including local 
tasks, public folder tasks, and other users’ tasks. The viewing options for Tasks include 
built-in views such as “Overdue Tasks” and “Next Seven Days,” in addition to any views 
that a user has created. Users can also select links that open shared tasks, share task 
information, modify permissions, or modify the options of the Current View. 

 
In the Tasks view, all tasks folders that the user can open, including local, public, and shared, are 
presented in a simple list. The Current View section provides an easy way for users to organize 
their tasks into logical groups. 
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Notes view 

The Notes pane shows a list of the user’s notes, including shared notes. Viewing options 
for Notes include built-in views such as “By Category” and “Last Seven Days,” in addition 
to any views a user has created. Links are also available to open shared notes, share the 
user’s own notes, modify permissions, or modify the options of the Current View. 

Folder List 

The Folder List is designed to help with data-file management activities such as archiving 
and copying between mailboxes. All local folders of all types are shown in the Folder 
List, just like the Folder List in previous versions of Outlook. Convenient links are 
available to help manage folder sizes and Outlook Data Files. 

Shortcuts 

The Shortcuts pane is a location for shortcuts to nearly anything: Outlook folders, 
programs, documents on the hard drive, files on a network, shared folders, Web pages, 
and more. The user can create groups to organize these shortcuts, and can collapse and 
expand these groups to use the space more efficiently. To add a shortcut, users can 
employ the provided link, or just drag and drop items onto the list. 

Journal 

The Journal pane shows a list of all Journal folders that are available to the user, 
including public and shared Journal folders. As with the Contacts, Tasks, and Notes 
panes, all available Journal views are shown in this pane and can be customized. Links to 
share or open shared Journal data are also provided. The Journal pane is off by default, 
but users can turn it on by using the Navigation Pane Options menu, or by selecting 
Journal from the Go menu to use it without adding to the Navigation Pane. 

Note  Each Outlook pane displays six options. By using the Navigation Pane Options 
menu, users can show, hide, or rearrange the panes. 
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Go menu 

The Go menu is back! The Go menu makes it easy to navigate through Outlook 2003 by 
using the keyboard. Users can also change their view of the Navigation Pane by using 
the Go menu. 

 
Users can take advantage of the Go menu or the integrated keyboard shortcuts for each of the 
modules of the Navigation Pane. 

 

 

 

 

 

 

To move quickly between Navigation Pane 
modules, use the keyboard shortcuts 
documented on the Go menu: 

• Mail CTRL+1 
• Calendar CTRL+2 
• Contacts CTRL+3 
• Tasks CTRL+4 
• Notes CTRL+5 
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Key functionality 
Several customer-requested improvements have been made to the process of addressing, 
composing, and sending e-mail messages in Outlook 2003. These features are designed to help 
all users be more productive with their e-mail. 

Streamline e-mail creation 
Simplified e-mail creation helps with overall efficiency and productivity. Outlook 2003 
now offers a simplified “Word Mail” user interface (using Microsoft Office Word 2003 as 
the e-mail editor), which is easier to use, is less confusing, and requires less training. 
Additional new features that help streamline e-mail creation include expandable 
distribution lists, improved AutoComplete, Unicode support, and Internet faxing. 

Expandable distribution lists 

Distribution lists can now be expanded to display the names of the people on the list, 
making it easy to add or remove a few names before sending the message. This 
eliminates the need to modify the distribution list or start from scratch when addressing 
an e-mail message to a distribution list. 

 
Click the plus sign next to a distribution list to expand it and list all members. 

 

 
Members of the distribution list appear after clicking the plus sign. 
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Improved AutoComplete 

AutoComplete now matches on just one letter instead of three, and the AutoComplete 
list is sorted by the most frequently used e-mail addresses instead of alphabetically. In 
many cases the user can address e-mail simply by pressing the first letter in that 
person’s name. Tablet PC users need only to place their cursor into the address line and 
to their most commonly-used e-mail addresses and choose the one they want. Users 
spend less time searching for the correct e-mail addresses and significantly reduce the 
required number of keystrokes overall. 

Simplified e-mail editor in Word 2003  

The experience of creating a new e-mail message has been vastly simplified. Commands 
have been consolidated into a single toolbar called “E-mail,” which is positioned directly 
above the text of the message. As a result, the number of buttons on the screen has 
been reduced by more than half, making it easier for users to find what they need, and 
leaving more room for the message. 

 
The Word e-mail editor has been redesigned with simplicity in mind. 

Unicode support 

Outlook 2003 supports Unicode for Contacts, Mail, Calendar, Tasks, and Notes. Users 
can view and edit text within Outlook 2003 in any language and any script that is 
installed and is supported by the operating system. Unlimited support for Multilingual 
User Interface enables IT administrators to switch the user interface and Help files to 
different languages based on the users' individual needs. 

 
Support for Unicode allows Outlook to appear in the user’s native language–in this case a Contact 
in Hindi. 
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Internet faxing 

With Internet faxing, faxes can be sent and received directly from a desktop computer, 
eliminating the challenges that can accompany using a fax modem, such as tying up the 
telephone line, incurring long-distance charges, and having to redial or manually confirm 
that the fax arrived. 

Office 2003 Editions integrate Internet faxing with its programs, including Outlook 2003. 
Some new faxing features include fax numbers made available in Contacts, a rich 
preview tool, the ability to calculate the cost of the fax before sending it, cover pages 
that are editable in Word 2003, and even the ability to sign your name by using a 
Tablet PC. 

Internet faxing in the Office 2003 Editions require users to sign up with one of the faxing 
services that partner with Microsoft Office (For a list of Microsoft Office fax partners, 
see Office Online at http://office.microsoft.com). 

Organize and prioritize e-mail 
Users are now faced with an increasing volume of incoming e-mail messages. This influx 
of messages requires more intuitive and efficient organizational tools.  

Quick Flags 

Studies of customers using Outlook found that most people do one of three things with 
nearly every e-mail message: 

1. Respond to it immediately.   

2. Delete or file it immediately. 

3. Save the message in some way as to indicate that a follow-up action is required. 
Because they lack the time or information that is required to take action right away, 
they decide to follow up on it later. 

There are almost as many approaches to the third option as there are users—mark the 
message as unread, move it to an e-mail folder named “To Do,” make a task out of it, 
delete or file all messages that don’t require a response, and so on. While these 
strategies may work for a particular individual, they are makeshift responses to an ever-
increasing volume of e-mail for which earlier versions of Outlook were not designed. 

Outlook 2003 offers Quick Flags as a simple solution to this problem. Activated by a 
single click, Quick Flags provide a means for users to “flag” messages for follow-up 
action or later reference. 

To assign a Quick Flag to a particular message, a user simply clicks the flag icon on an e-
mail message from any folder in Outlook 2003. Each marked or "flagged" message has 
one of several colored flags (as chosen by the user) visible next to it so that it is easy to 
find at-a-glance. Users can choose colors that work best for them, such as red for high 
priority or blue for personal to-do items. 
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Items marked with a Quick Flag are automatically stored in the For Follow Up folder, 
which becomes an automated, virtual to-do list in Outlook. The For Follow Up folder 
shows all flagged items at-a-glance, and enables users to work with and organize items 
by color. For more information about the For Follow Up folder, see the following 
section. 

 

 
Click the gray flag icon to Quick Flag an e-mail item. Click the icon again to mark it complete. The 
“Insert” key can also be used to add or complete a Quick Flag.  

 
Users can also select one of six different colors from a right-click menu to categorize their follow-
up items easily. 
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Using the For Follow Up folder 

To make finding messages even easier, a special Search Folder called “For Follow Up” 
exists. This folder always contains an up-to-date list of all messages that have been 
marked with a Quick Flag for every folder in the Inbox. A user who is ready to take 
action on these messages can open the For Follow Up folder and find every message 
that has been marked. When finished with a message, the user simply single-clicks again 
to mark it as Complete, and the message is stamped with the date/time it was 
completed. The For Follow Up folder is a default folder that is located in the Favorite 
Folders section. 

 
The “For Follow Up” folder collects a to-do list of every item that has been Quick Flagged in every 
folder in a mailbox. By default, it is arranged by Quick Flag color so that users can easily see what 
goes with what. Also, users can drag a message between groups to reclassify it. For example, to 
turn a yellow quick flagged item into a red quick flagged item, a user could just drag the message 
from the yellow group to the red group. 
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Quick Flagged messages can also be arranged by date. 

 

 
Outlook records the date and time the task was completed, and displays it in the InfoBar on the 
top of the message. 
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Search Folders 

Search Folders help users spend less time filing and finding e-mail messages. Search 
Folders are actually live search results that look like traditional e-mail folders, but differ 
because they do not store e-mail messages. They are virtual folders that contain views 
of all e-mail items matching specific search criteria. Search Folders display the results of 
previously defined search queries, but all e-mail messages remain in their original 
Outlook folder. By using Search Folders, users can easily group and browse through all 
items relating to a subject, person, task or other criteria, without physically moving 
messages or folders. 

 

 
Search Folders work just like folders, except that they can reference e-mail messages from 
multiple folders. 
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Users can drag frequently used folders or Search Folders to the Favorite Folders section of the 
Mail pane to keep them handy. This reduces the need to navigate through a deep hierarchy. 

Using default Search Folders 

Three Search Folders are created for users by default, so even beginners can take 
advantage of this new tool: 

Unread Mail. All unread e-mail messages, regardless of their folder location, are shown 
in the Unread Mail search folder. 

For Follow Up. This folder provides a virtual to-do list of all messages that have a Quick 
Flag applied. 

Large Mail. This folder assists with mailbox cleanup by showing the largest e-mail 
messages from the entire Inbox. 
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Creating customized Search Folders 

After using the default Search Folders, intermediate users will want to create their own 
folders for customized searches. To make this as easy as possible, Outlook 2003 offers a 
template gallery that includes 13 ready-made templates for common Search Folders. 
These templates make it possible to create a wide range of Search Folders in just a few 
clicks. The following are some key Search Folders that can be created from templates: 

• Important Mail. This provides a central location for all e-mail messages that are 
marked as having high importance. 

• Mail from and to a specific person. This helps users to stay current with 
customer and personal relationships. For example, it can help answer questions 
such as “Do I owe Janet a message?” or “Where is that e-mail conversation I had 
with Marc?” 

• Old Mail. This is helpful in locating old messages for archiving. 
 

 
To create a new Search Folder with the template gallery, from the File menu, click New and select 
Search Folder.  
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Users can also create a custom Search Folder by choosing the last template, “Create a 
custom Search Folder.” Under "Customize Search Folder," users simply click "Choose," 
and type a name for their customized Search Folder. After selecting the search criteria 
for the customized folder, the user can select and search the folders they want to 
browse.  

 
Users can create Search Folders by modifying existing templates. 
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Saving searches from Find or Advanced Find as Search Folders 

By using Find or Advanced Find, users can save any search that was created with 
Outlook 2003 as a Search Folder or use any of the templates that are provided to create 
a customized search folder. In both cases, the user can specify not only the search 
criteria, but also which folders Outlook 2003 searches to create the Search Folder. 
Search Folders can be easily customized at any time. Users can even perform another 
search within the contents of a Search Folder to refine their results further. 

 
Users can also save search results from Find or Advanced Find as a Search Folder. To save the 
results of Find as a Search Folder, on the Find bar, click Options and select Save as Search Folder. 
To save the results of Advanced Find as a Search Folder, from the File menu in the Advanced Find 
dialog box, click Save as Search Folder. 
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New Mail Desktop Alert 

Outlook 2003 offers a new desktop alert to replace the previous new e-mail message 
alert. The New Mail Desktop Alert fades in subtly with the name, subject, and a short 
text preview. It appears just long enough that users can immediately see whether the 
new message is urgent, should be marked for follow-up, or can be safely ignored 
without interrupting the current task. The alert contains quick buttons to open, flag, or 
delete the e-mail message, and if ignored, fades out just as subtly as it appeared. This is 
completely configurable by the user. 

 
The New Mail Desktop Alert appears while users are working in programs other than Outlook. 

 



 

 
 
 

66 

Bigger Personal Folders file 

The improved Personal Folders file (*.pst) stores up to 20 GB of data by default 
(administrators can specify a larger folder if they choose) and supports multilingual 
Unicode data. The new Outlook Personal Folders File will not work with earlier versions 
of Outlook. Outlook 2003 still supports Outlook 97-2002 Personal Folders files, which 
are limited to about 2 GB of data. These improvements are also leveraged for the Offline 
Folders files (*.ost). 

 
When creating a new Personal Folders file, the new format Microsoft Outlook Personal Folders 
File is used by default. On the File menu, use the New Outlook Data File entry to create new 
Microsoft Outlook Personal Folders and also backwards-compatible Microsoft Outlook 97-2002 
Personal Folders Files, so users who have older versions of Outlook on a home computer can still 
create compatible personal folders. 

Prevent unwanted e-mail 
Unfortunately, in addition to an increasing volume of e-mail, users are being inundated 
with junk e-mail. These e-mail messages can be bothersome and distracting, but they 
can also have a more serious impact by taking up valuable storage space. 

Block external content 

By default, Outlook 2003 helps protect the privacy of its users, and provides them with 
more control over the information in their Inbox. This protection is enabled through a 
new feature called Block External Content.  

HTML-formatted messages often contain pictures that are not included in the actual e-
mail message, but are instead downloaded from a Web server when the e-mail message 
is opened. Junk e-mail senders have used this capability to their advantage by including 
something called a “Web beacon” in these messages. A Web beacon notifies the Web 
server when a user reads the junk message, validating the e-mail address. If an e-mail 
message tries to connect automatically to a Web server on the Internet, Outlook 2003 
blocks that connection until the user decides to view the content, which takes only one 
click. The user can also turn off this feature. 
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Giving users control over external content has several advantages: 

• Automatic connections to arbitrary Web servers on the Internet are no longer 
allowed, cutting off the unwanted flow of information to e-mail solicitors. 

• Because pictures are not shown unless requested, offensive messages can be 
deleted without the user being subjected to its images. 

• Users on a low bandwidth connection can choose whether an image is valuable 
enough to warrant the time and bandwidth to download it. 

It is important to note that Outlook 2003 retains all of its rich functionality for viewing 
and sharing pictures. Outlook 2003 will block all pictures by default if they are sent with 
the message and not on a Web server.  

• Content creators who want to send richly formatted HTML e-mail to their 
customers can still do so by including the pictures in the body of the e-mail 
message.  

• Pictures that are inserted into e-mail by using Outlook or Outlook Express 
already use the MHTML standard by default and include the pictures in the 
message, so they are not affected. 

• Any e-mail that includes references to images or content on the Intranet or on 
Trusted sites (defined by the Intranet and Trusted zones of Internet Explorer) 
will not be affected. 

• Any e-mail messages that were sent from someone on a defined list of trusted 
senders will not be affected. Users can easily add e-mail addresses to this list 
(which includes the corporate directory and the user's local contact folder by 
default). 

 
Mail messages that attempt to download content from the Internet are not allowed to make the 
connection without the user’s permission. The colored InfoBar strip at the top of the message lets 
users know that the content was blocked. 
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Clicking the InfoBar brings up a context-sensitive menu. Users can turn on images for a specific 
message using this menu. Users can also add individual e-mail addresses to a “Trusted Senders” 
list, to disable content blocking for all mail from that address. 

Working with Outlook 2003 Rules and Alerts improvements 

The experience for creating new rules to handle e-mail messages has been streamlined 
and made easier for common rules and to view and change rules once they have been 
created.  

Common rule actions can be viewed graphically and modified quickly. In addition, users 
can associate alerts with their rules to stay abreast of current information. 

To view the new Rules and Alerts functionality, do one of the following: 

• Go to the Tools menu and click Rules and Alerts, or 
• In the Rules and Alerts dialog box, click New Rule, or 
• Right-click on any e-mail message and click Create Rule 

Filter Junk e-mail 
Outlook 2003 includes functionality that has been designed to help eliminate much of 
the unwanted e-mail that users get every day. These features give users control over the 
kinds of messages they receive, and from whom. 

Features 

Outlook 2003 provides a set of features that are designed to work together to help 
protect users from unsolicited e-mail messages: 

• Trusted Senders list. If an e-mail message is mistakenly marked as junk by the 
filter, the user can add the sender of that message to the Trusted Senders List. 
E-mail addresses and domain names on the Trusted Senders List are never 
treated as junk e-mail, regardless of the content of the message. Contacts are 
automatically trusted by default, and mail from them will never be treated as 
junk. With Microsoft Exchange Server, mail from within the organization will 
never be treated as junk, regardless of the content of the message. Users can 
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configure Outlook 2003 to accept mail only from the Trusted Senders List, giving 
users total control over which messages reach their Inbox. 

• Junk Senders list. E-mail from a certain e-mail address or domain name can 
easily be blocked by adding the sender to the Junk Senders List. Mail from 
people or domain names on this list are always treated as junk, regardless of the 
content of the message. 

• Junk e-mail filter. Outlook 2003 uses state-of-the-art technology developed by 
Microsoft Research to evaluate whether a message should be treated as junk e-
mail based on several factors, such as the time it was sent and the content of 
the message. The filter does not single out any particular sender or type of e-
mail; it is based on the content of the message in general and uses advanced 
analysis of the structure of the message to determine how likely it is to be 
thought of by the user as junk. 
By default, this filter is set to a low setting which is designed to catch the most 
obvious junk e-mail. Any message that is caught by the filter is moved to a 
special “Junk E-mail” folder, where a user can retrieve it at a later time. The user 
can choose to make the filter more aggressive (perhaps mistakenly catching 
more legitimate messages), or even set Outlook 2003 to permanently delete 
junk e-mail as it arrives. 

 

• AutoUpdate. Microsoft is committed to providing periodic updates of the Junk 
E-mail Filter so that it continues to be effective.  

• Trusted Recipients list. A mailing list can also be added to the user’s Trusted 
Recipients List. Any e-mail that is sent to e-mail addresses or domain names on 
this list will not be treated as junk, regardless of the content of the message. 

The Junk E-mail Filter is turned on by default. The first time Outlook 2003 moves an e-
mail to the Junk E-mail folder, it will notify the user by way of a dialog box.  
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How to customize 

Users can customize junk e-mail settings to meet their needs. To change Junk E-mail 
settings, select Options from the Tools menu and click on Junk E-mail. To add people to 
the Trusted Senders, Trusted Recipients, or Junk Senders lists, right-click the message 
and click Junk E-mail, or click Junk E-mail on the Actions menu. For versions of Microsoft 
Exchange Server without Cached Exchange Mode (see Cached Exchange Mode), the junk 
e-mail filtering must be installed and configured on the computer running Microsoft 
Exchange Server. 

 

 
The first time Outlook 2003 downloads an e-mail message that appears to be junk e-mail, a 
dialog box appears to inform the user. By default, this dialog box comes up each time a suspected 
e-mail message is downloaded—however, it can be easily turned off by clicking “Please do not 
show me this dialog again.” 

 

 
Suspect messages are moved to the “Junk E-mail” folder by default. 

 



 

 
 
 

71 

 
The Junk E-mail Options can be opened from the Tools menu, under Options-> Junk E-mail. The 
user can choose the appropriate level of protection, ranging from no protection to trusted lists 
only. The user can also choose to permanently delete mail instead of moving it to the Junk E-mail 
Folder. 

Enable worker mobility and productivity 
Outlook 2003 provides many technical advances that help users connect to information 
and use it more effectively without having to worry about issues such as network 
performance. 

Cached Exchange Mode 

The new Cached Exchange Mode in Outlook 2003 delivers a reliable and responsive user 
experience independent of network performance by loading all necessary data up front 
rather than as e-mail is read. Cached Exchange Mode insulates the user from network 
issues, ensuring that the user is able to remain productive at all times. As such, the 
feature provides advantages for IT directors, reducing support calls, making server site 
consolidation possible, and enabling a new set of mobile scenarios. On a new 
installation of Outlook 2003, Cached Exchange Mode is on by default. With an upgrade, 
the user can enable Cached Exchange Mode. 

For several releases, Outlook 2003 has had the ability to synchronize data between the 
Exchange server and its local store. Users can presently use Send/Receive groups to 
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synchronize their data. Office 2003 Editions offer the ability to use the new Cached 
Exchange mode in Outlook 2003 to synchronize data continuously.  

When working with Exchange Server 2003, synchronization is more efficient and robust 
because the server and client communicate in a way designed to reduce the amount of 
data that is transferred between the client and server during synchronization. These 
improvements are especially important for mobile scenarios in which the connection 
from Outlook to the Exchange server is over a network that has limited bandwidth and 
variable latency. This efficiency results in cost savings on “pay-by-the-byte” networks, 
and generally reduces the amount of time that is required to complete any 
synchronization, making the benefits automatic.  

Intelligent connectivity 

The intelligent connectivity feature introduces network “awareness” to Outlook 2003, 
so that the program is more responsive over low-speed or unreliable network 
connections, or when a user is moving from one wireless network connection to 
another. This enables Outlook 2003 to remain usable, and when combined with the 
Cached Exchange Mode, actually hides the network reliability from the user almost 
entirely—no more connection-error messages. 

The synchronization modes of Cached Exchange Mode include Download Headers and 
then Full Items, Download Full Items, Download Headers, or On Slow Connections 
Download Headers Only (the default mode for a slow connection, which can be 
overridden). Users can change the Cached Exchange Mode connection setting by 
selecting "Cached Exchange Mode" from the File menu, and then selecting one of the 
following synchronization modes:  

Download Headers and then Full Items – Downloads all headers, and then complete 
items including attachments. Users can click a header and the full item is downloaded 
immediately. 

Download Full Items – Downloads the header, body, and any attachments 
simultaneously. This mode is effective with a network connection or a continuous dial-
up connection. 

Download Headers – Downloads headers only. The full item including attachments is 
available when the user previews or opens the item. This mode is useful to keep the 
amount of data transferred between Outlook and the computer running Microsoft 
Exchange as small as possible. 

On Slow Connections Download Headers Only – This is the default setting for a slow 
connection. The body, including any attachments, is downloaded only at the user's 
request, or as needed for synchronization or auto-archiving. The Offline Address Book is 
not downloaded. This mode is effective when using dial-up connections, or cellular 
wireless with General Packet Radio Service (GPRS) connections.  
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The Cached Exchange Mode menu shows the options that are available when connecting to slow 
or unreliable networks. 

Connectivity to Exchange via HTTP 

Gaining access to a Microsoft Exchange server by using Outlook has traditionally 
required direct access to the server, either through a local area network (LAN) 
connection or by connecting remotely through a virtual private network (VPN) 
connection. With Outlook 2003 and Exchange Server 2003 running on Microsoft 
Windows Server 2003, users can open their Exchange server computer directly by way 
of HTTP over an Internet connection. By using Outlook 2003, if a user can browse the 
Web, the user can open his or her Exchange mailbox. 

After the feature is operational, Outlook 2003 automatically connects by way of HTTP 
when a direct connection to the Exchange server is unavailable, eliminating the need to 
have corporate VPN servers set up for e-mail access. 

 
Office administrators can now easily configure Outlook 2003 to communicate with an Exchange 
server over the Internet. 
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Notification Area icon 

Most people keep their e-mail program running all the time. The new Notification Area 
icon in Outlook 2003 makes it possible for users to stay on top of their e-mail messages 
even when working in another program. The Notification Area icon shows the status of 
Outlook 2003, even when the program is hidden, minimized, or in the background.  

The Notification Area icon displays different types of information in new ways: 

• Informational messages. Outlook 2003 provides alert and reminder information 
to the user in a less intrusive manner. Notification “pop-up balloons” now notify 
the user of status changes and other information in a subtle manner, allowing 
the user to continue working. In previous versions of Outlook, message boxes 
indicating status would appear and block the screen. With Outlook 2003, users 
can read the message if they choose, but do not have to respond. Users can also 
choose to opt-out of groups of messages that they do not want to receive in the 
future.  
Note  Opting out of receiving messages does not affect any error logs that might 
be created. 

• Synchronization status. This icon shows when Outlook 2003 is downloading and 
sending e-mail. This is useful when a user wants to work in another program 
until Outlook 2003 is finished sending or receiving e-mail. 

• Network problems. If Outlook 2003 has a problem with the network or with the 
e-mail server, it notifies the user by changing to a “trouble” icon. In most cases, 
configuration data is still available, but no new messages are received until the 
trouble is resolved. Users can cancel the network operation by clicking the icon 
and selecting “Cancel Request.” 

 

 
The Notification Area icon can show informational messages in pop-up balloons. The Notification 
Area icon is always available in the notification area of the Windows taskbar. Click or right-click 
the icon to bring up the menu. Double-click to bring up Outlook (even when Outlook is totally 
hidden). 

Kerberos authentication 

Besides NTLM, Outlook 2003 supports Kerberos authentication when running 
Exchange Server 2003, giving corporations more options for meeting their 
authentication needs. 
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More effective contact management 
Users can now take advantage of enhancements to the Address Book, including an 
updated interface and the option to insert a picture.  

Improved Address Book interface 

The Select Names dialog box in Outlook has been redesigned to help users view more 
information on the screen at one time. The dialog boxes are completely resizable based 
on user preferences, making it possible to take advantage of today’s larger monitors, 
and common commands have been made more prominent in the user interface. 

 
The new Address Book Chooser is resizable and has been redesigned to be more intuitive. 
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Contact picture 

The ability to add a picture to Contacts is one of the most frequently requested features 
from customers. With Outlook 2003, pictures can be added directly to the contact 
information, giving users the ability to associate a face with the name and other 
available information. 

 
The contact with a picture added. 

Bringing relevant information to people’s fingertips 
The Office 2003 Editions have created two new panes to bring relevant information to 
its users: the Document Recovery pane and the Research task pane. The Document 
Recovery pane safeguards users against the loss of data, while the Research task pane 
allows users to browse the Web for information within the program that they are 
working from. 

Document Recovery pane 

The Document Recovery pane in Microsoft Office PowerPoint® 2003, Word 2003, and 
Microsoft Office Excel 2003 helps prevent the loss of work when one of the programs 
encounters a problem and stops responding. The files that are listed in the Document 
Recovery pane can be opened, their repairs can be viewed, the files themselves can be 
compared, and one or all of the files can be saved. The listed files are clearly labeled as 
“original” and “recovered.” The Document Recovery pane allows users to connect with 
the temporarily lost information quickly and easily. 
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Research task pane 

Each Microsoft Office program and Microsoft Internet Explorer (through an Office add-
on) now includes a Research task pane that allows users to search for information 
through the Web or a corporate data source from directly within the program. Now 
users can access corporate data and work with their research information right 
alongside their reports, charts, and other documents.  

Search results can be pulled into the document without switching programs, and 
through the use of smart tags, the data source can provide a variety of actions beyond 
the typical copy-and-paste of HTML that a Web search would accomplish. For example, 
a search against a corporate data source could provide the option to refine the search 
with additional parameters, insert the results as structured XML data into Excel, or 
present the information as a linked, refreshable XML document fragment from a 
content database.  

 
Through the Research Library task pane, users can research the Web or corporate resources right 
alongside their documents. 

 

Research task pane vs. ordinary Web searches 

A Web search searches only publicly available information, and returns only formatted 
text or, occasionally, documents as the results. The results are viewable only in a 
browser, not in any Office programs. 
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The Research task pane searches the Web as well, but it also searches numerous other 
sources that are not available to Web searches, including the following sources: 

• Subscription services such as Factiva, e-library, or Gale company profiles (you or 
your company must be a subscriber) 

• Microsoft services such as dictionaries, thesauri, or the Microsoft Encarta® 
encyclopedia 

• Translation services through Microsoft partners 
• SharePoint Portal server computers inside of a company's firewall 
• Corporate databases inside of a company’s firewall that have been provided 

with a Research Library front-end (either on the server or on the client), such as 
customer databases, sales data, product catalogues, or support databases 

Most powerfully, the Research task pane is not limited to returning only formatted text 
as a result. It can return XML data from Web services or databases. Using smart tags 
linked to the data types returned, a service can provide the user with options to insert 
the data into programs or take special actions. For example, if sales data is returned 
from a search in Excel, the service can provide an action to insert the data as a 
refreshable Web query or to create a PivotTable or PivotChart. Likewise, the same 
service might offer different actions in Word 2003 or PowerPoint 2003.  

An SDK is available to developers to help them build their own research services, or to 
put a research front-end on an existing data source. Many partner vendors are already 
preparing research front-ends for their server products and services. 

Research Library closes the XML data loop by letting end-users access all the data inside 
or outside of an organization and reuse it within Office programs. 

Research task pane tools 

The Research task pane also includes basic resources such as a thesaurus and 
dictionaries in multiple languages (available even offline), as well as automated 
translation and an encyclopedia on the Internet. If the user or corporation has signed up 
with third-party data service partners such as Factiva, eLibrary, and others, these are 
also searched and the results are presented in the Research Library.  

Looking up information by using the Research task pane is simple: simply hold the Alt 
key and click on a word in your document. Users can also right-click or use the menu or 
toolbar to open the Research task pane. It will appear with results even if it was not 
open when the search was initiated. 
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In Microsoft Outlook 2003, the Research pane makes it easier to read foreign-language 
e-mail messages, because a single click will provide a translation of a word, or the entire 
e-mail message, to the user’s native language. This is especially useful in multinational 
corporations where many users do not natively speak the predominant language. 

 
The Research Library task pane provides a variety of tools and resources.  
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Flexible information management technologies 
Ink integration in Office 2003 Editions programs 

In Office XP, Tablet PC users were able to download the Microsoft Office XP for 
Tablet PC (Tablet Pack) add-in to create ink e-mail messages and to draw in Word 
(comment bubbles only), Excel, and PowerPoint; and annotate presentations. In 
Office 2003 Editions, ink is integrated directly into the programs, allowing ink users to 
use more functions and use ink more effectively for annotating and drawing within their 
documents. Support for ink has also been improved throughout the Office suite. 

The following are some of the benefits of tighter ink integration with Office 2003 
Editions: 

• Handwriting within 2003 Editions programs. Users can treat their Word 
documents, Excel worksheets, and PowerPoint slides as a piece of paper, 
making notes directly on top of the document or in the margins, sketching out 
ideas and saving them for later, without having to worry about supplemental 
software to accomplish the notation.  

• Show and hide ink markup. Integration of ink annotations with the Reviewing 
toolbar in Word 2003, Excel 2003, and PowerPoint 2003 allows users to show 
and hide their ink mark-ups in the same way as other comments and revisions.  

• Write inside of Word comments. Word 2003 provides an ink comment bubble 
feature, which allows users to ink inside of Word comments with all of the same 
features, such as the ability to filter by author. Using Comment bubbles ensures 
that the annotations will remain anchored to the text that was commented, 
even as the document is edited later. 

• Comment “anchoring.” Office 2003 Editions also take the first step toward true 
integration between ink annotations and words on the page, with limited 
support for document reflow and anchoring. In Excel, annotations will move as 
columns are inserted, so ink comments remain over the relevant item. In Word, 
annotations are linked to paragraphs, so edits elsewhere in the document leave 
ink annotations in the correct place. Changes to annotated paragraphs on the 
word or line level are not yet supported in Word—such edits might cause the 
ink annotations to drift from the words to which they should be connected. 
Users are notified that annotations may shift when switching between Reading 
Layout and Print Layout views for printing. Annotating in Print Layout view is still 
a better choice for those who want to print their annotations.  

• Two ink modes. In addition to annotating directly on the document surface, 
users can insert hand-drawings in Word 2003 through the same interface as 
pictures or text boxes. The user is given a “canvas” inside the document, which 
acts like an ink picture. Double-clicking on the ink image produces a “format ink” 
dialog box, in the same way as a text box or picture, with options to wrap text 
around the ink, resize the canvas, and so on. 

• Two ink toolbars. An ink toolbar is available for drawing and writing, and 
another for annotations. Each provides a set of ballpoint pens, felt tip pens, and 
highlighters, enabling users to change the color and width.  
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• Familiar interface. Other ink features in the Office 2003 Editions use the same 
familiar interface that is found in the previous Tablet Pack.  

• Copy and Paste. Users can copy and paste ink objects between programs. 

 
Users can now write notes directly in documents in Word 2003. 
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Support for ink is enhanced throughout the Office 2003 Editions. Here, a user adds handwritten 
notes to an Outlook e-mail message. 

 

Word 2003 Reading Layout view 

The new Reading Layout view in Word 2003 makes it easier to read documents on-
screen, rather than printing them out. Outlook attachments and documents opened 
read-only from SharePoint server computers will automatically open in Reading Layout 
view. The following are some advantages of this mode: 

• Optimized experience for on-screen reading. The document is laid out in virtual 
pages that are optimized in size for the particular display that is in use. The text 
is displayed with clean margins, shorter lines, a larger font and, space 
permitting, two pages per screen to make on-screen documents easier to read. 
Text is displayed by using an improved form of ClearType for smooth display and 
reduced eyestrain. 

• Useful aids to reading. Toolbars are simplified to show only the tools that are 
useful for reading and review. These include the new the Research task pane 
(see Research), where simply clicking on a word in the document will show 
definitions, translations, encyclopedia articles, and other related content from 
the Internet and corporate intranet; commenting tools (typed, spoken, and even 
handwritten if on a Tablet PC); the Find feature; and buttons to increase or 
decrease font size temporarily for reading purposes. 

• Easier navigation. Rather than scrolling, pages are flipped one or two at a time 
to simulate the experience of reading a book, which reduces eyestrain by 
making it easier for a user’s eyes to track the text. Users can browse a document 
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by using the new thumbnail view, which lets them jump to a particular page by 
clicking on an image of that page, or by using the document map, which displays 
the structure of the document similar to a table of contents. Users can also 
navigate by using the mouse wheel, or any of several different keystrokes (for 
example, SPACEBAR, PAGE DOWN, DOWN ARROW, ENTER to move to the next 
page, and UP ARROW, PAGE UP to move to the previous page). 

 
A document displayed in the Reading Layout view 

Not every document can be displayed well in Reading Layout view. For the most 
complex documents, a button called Actual Page can be used to display the document 
as it would be printed. This button is also useful to switch temporarily to the original 
print version of the document to view a particular layout. 

Office document imaging 

Document imaging in Outlook 2003 enables users to scan paper documents and convert 
them to digital images that can be stored on a hard disk, network server, CD, or DVD. 
Digital images can be saved in TIFF or MDI file formats.  

Two components make up Document Imaging—the Scan component and the Imaging 
component. On the Office Start menu, these appear as Microsoft Office Document 
Scanning and Microsoft Office Document Imaging.  

• Office Document Scanning—Use the Scan component to make scanned 
documents available on the user's computer by using any installed scanner. The 
presets that control the scanner are optimized for specific purposes. Black and 
White produces the best results when scanning text; Color produces the best 
results when scanning pictures or artwork. 
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• Optical character recognition—Optical Character Recognition (OCR) translates 
images of text into actual text character. By using OCR, users can manipulate 
text, search, or copy text to another program. For best results, use the Black 
and White preset for OCR. 

• Develop image-based custom programs—Users can insert images from the 
scanner into a Word document by using Office Document Scanning, or by using 
the software that came with the scanner.  

• Annotate images—Users can annotate images easily for document sharing. 
• Office Document Image Writer—By using the Document Image Writer, users 

can view scanned documents on-screen, rearrange multiple-page documents 
with ease, select and work with OCR text, and annotate or send fax documents. 

Picture Manager 
Microsoft Office Picture Manager provides a flexible way to manage, edit, and share 
pictures. Users can view all pictures, regardless of where they are stored, and the Locate 
Pictures features assists with searching. Office Picture Manager can automatically 
perform corrections to pictures, or users can make specific adjustments by using the 
individual picture-editing tools. Sharing pictures is easier and more powerful; pictures 
can be sent in e-mail messages or users can create a Microsoft SharePoint Picture 
Library on a corporate intranet. 

 
Use the Picture Manager to sort and find pictures. 

 

Managing pictures 
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To avoid navigating between locations and long lists of folders to locate pictures, users 
can now add shortcuts to all the locations that contain pictures. Office Picture Manager 
works with the current folder hierarchy and does not require the user to create new 
categories or import pictures. After a shortcut has been added, users can work with 
pictures from any location as if working directly from the file system. 

Editing pictures 

Users can change how pictures look by adjusting these settings and tools: brightness 
and contrast, color, crop, rotate and flip, red eye removal, and resize. After editing is 
complete, users can save the edits to the current file or keep the original file by 
exporting the changed picture to another file name or to another location. 

Sharing pictures 

After editing is complete, users might want to share them with a workgroup. Pictures 
can be sent in e-mail messages, or users can create a SharePoint Picture Library for a 
rich collaboration experience. The SharePoint Picture Library offers simplified 
administration and role-based permission settings, in addition to a unique picture-
management model that enables users to download picture versions at any size or 
resolution, while efficiently storing the original pictures.  

Shared pictures can be compressed to a file size that is the most efficient for the sharing 
medium. Smaller file sizes appear more quickly on Web pages, and take up less disk 
space. If the user is sharing pictures in e-mail messages, smaller file sizes are sent more 
quickly. 

Summary 
With Microsoft® Office 2003 Editions, users have new ways to stay organized and manage the 
details that accompany information overload. New design enhancements to Outlook 2003, 
including the new Reading Pane, Search Folders, and Quick Flags help users save time and 
manage information more effectively. 



4 Connect Business Processes  

 
 
 

86 

 

 

 

Introduction 
The Microsoft® Office 2003 Editions integrate support for Extensible Markup Language (XML) in 
a way that can help companies create new, simple, and efficient processes for everyday 
business functions, such as invoices, contracts, press releases, reports, presentations, customer-
facing e-mails, and more. The new processes combined with the power of XML can bring all 
departments together and save time by eliminating the need to pass documents back and forth 
among departments and people. 

Business process management challenges 
Because different departments in an organization have varying needs for consuming and 
reporting the same data, sharing information between departments can be difficult. 
Often, data output from one department is in the wrong form or file type to be opened 
or used by others. This means that departments must spend extra time reworking data 
to fit their needs and then verifying that it remains accurate. 

Business value of XML in Office Professional Edition 2003 
A surprising amount of business information stored today is already in XML format, or 
can be easily converted to XML as it is used. All major database tools on the market 
today—from any vendor—support access to stored information by using XML format. A 
solution developer can simply request information as XML by using the correct 
interface, and the database server automatically generates the XML. 

Support for customer-defined schemas in Office Professional Edition 2003 means that 
the data coming from these databases can be used directly in the Office programs. 
Likewise, data collected or created in Office Professional Edition 2003 can be submitted 
to existing databases without reworking the data. 

With Office 2003 Editions, there is no need to wait for existing business information to 
be converted to XML—most of it is already available to power users and solution 
developers who are trying to make business processes more efficient. Although XML is 
implemented in all of the Microsoft® Office 2003 Editions, this chapter focuses on XML 
implementation in Office Professional Edition 2003. 

In Office Professional Edition 2003, the broad implementation of industry-standard XML, 
integrated task panes for research and communication, and expanded Smart tag 
capabilities help bring relevant and current business data to the user from within Office 
system programs. The task panes also provide a platform for business process solutions 
to be built on top of the familiar Office interface. 
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The following are some of the benefits of XML: 

• Easy exchange of data. XML allows data to be retrieved and used from 
disparate and otherwise incompatible systems.  

• Simple reuse of data. Reuse of information through XML eliminates the need to 
re-key or recode, and thereby reduces the time required and errors generated 
in repurposing information. 

• Easily searchable information. XML helps give structure and meaning to 
electronic information, so that information becomes much easier to search and 
organize. 

• Different views of the same data. Because XML separates content from its 
presentation, the same information can be used in different environments, 
formats, programs, and devices, depending on the user's needs. 

• Rapid solution development. Because more structured information uses the 
industry-standard XML data tags, business applications can be written from the 
ground up by developers, or even generated by experienced users, more quickly 
and easily.  

New feature highlights 
The new support for XML in Office Professional Edition 2003 is broad and deep across 
several products—in ways that are groundbreaking for desktop software.  

Structuring data and creating solutions 

Office Professional Edition 2003 provides support for customer-defined XML Schema 
Definitions (XSDs), meaning power users and developers can structure their data in a 
way that makes the most sense for them, and companies can create integrated business 
solutions inside of documents that interact with other valuable XML-based Web services 
that any user can take advantage of, even without knowing anything about XML. 

Retaining rich formatting in documents 

Microsoft Office Word 2003 can open and save files in any XML schema. When saving as 
XML, users also have the option to include, in addition to their own XML data, XML that 
describes the document formatting by using the WordML schema. Including WordML 
lets users retain all of the rich Word formatting when saving in XML format, so users can 
open the file and continue editing later with no loss of fidelity. The XML file can also be 
opened later in another program for searching or reuse of document fragments. A 
developer can build a document template that contains embedded XML, and anyone 
who uses that template will then produce valid XML output without knowing anything 
about XML. A collection of XML documents can be searched as readily as a database, 
enabling businesses to unlock the information that is stored in documents across the 
organization. All of this turns Word into a powerful tool for managing, modifying, and 
formatting business data. 
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Manipulating XML-based data 

Microsoft Office Excel 2003 can now read data within any customer-defined XML 
schema without the data having to be reformatted. Manipulating XML-based data in 
Excel for reuse and analysis is now as easy as selecting from a field chooser. Excel can 
also use XML to update charts, tables, and graphs as changes are made to the 
underlying XML data store, providing dynamic, real-time information for analysis in any 
Excel format. 

Defining XSDs for exporting data 

Microsoft recognizes that each customer has an individualized approach to business, 
and uses specific types of documents and data. For example, a purchase order 
document for an automotive parts supplier is a very different document from a legal 
contract written in a law firm. 

Accordingly, the XML support in Office Professional Edition 2003 is not merely a way to 
save the formatting of a document. Instead, the Office programs allow a solution 
developer or power user to incorporate the actual structure of business data that is 
used by a particular customer into that customer's documents. This is done by creating 
or using an existing XML schema that identifies the parts of a document. In the case of 
the purchase order, these parts might include the customer name, ID#, item description, 
item ID, quantity, price, and so on. 

After these parts of a document are identified in a template, anyone using that template 
or solution—even someone without any knowledge of XML—will be processing and 
creating XML data in the format that best suits the particular business needs. The data 
can then flow directly into business systems and processes. 

In contrast to this, the “native schema” for Word or other programs is simply the 
schema that is used to contain the formatting for the document so it can be saved and 
re-opened in Word without loss of fidelity. To make this most accessible for customers 
who may want to use this formatting information, the schema (or file format) is fully 
documented in the Office 2003 developer tool kit. 

For users who want to extract data from one or more tables in a database, Microsoft 
Access is the most appropriate Office tool. With Microsoft Office Access 2003, users can 
browse through related tables in a database and choose how to export data by defining 
the structure of a customer-defined XSD. 
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Key functions that are enabled by XML in 
Office Professional Edition 2003 
Support for XML in Office Professional Edition 2003 helps to seamlessly integrate data into 
related documents, spreadsheets, and databases, streamlining business processes. Along with 
providing full access to standard XML features, new XML-based tools in Word 2003, Excel 2003, 
and Microsoft Office Access 2003 help users to interact with data and documents more easily.  

Freeing up critical business information 
Time and again, businesses have expressed the need to capture important business 
information in a way that allows them to reuse it in other documents or business 
processes, regardless of servers, programs, or platforms. To fulfill this need, Microsoft 
has built XML into the heart of Office Professional Edition 2003 programs by creating 
and enhancing the following features:  

• XSDs. Support for standard and user-defined XSDs better enables data to fit 
needs. 

• Research task pane. Efficient access to relevant data increases productivity. 
• Smart documents. Enabling custom solution development and deployment 

streamlines business processes. 
• Programmable task panes. Displays of relevant tasks and information help to 

automate daily work. 
• Real-time data. Real-time updates to data that is inserted from other sources 

helps reduce valuable time spent on research. 
• Smart tags. Information and action options that function while data is being 

entered help automate work. 
Support for XSDs 

XML markup can be used to create "semi-structured" documents with regions of 
meaning, in addition to presentation and formatting. By creating or using specific XML 
schemas that define the structure of the document and the type of content that each 
data element contains, businesses can customize data presentation for their own use, 
making it easier to manipulate, search, and reuse information. XML bridges the gap 
between unstructured documents and rigidly structured data. 

The World Wide Web Consortium (W3C) has created a standard for generating and 
describing XML schemas that is known as the XML Schema Definition Language, or XSD. 
Because each company knows best what type of data it needs to capture, it can define 
for itself the XSDs that are most relevant to its own business. This is called a “customer-
defined schema,” as compared to one that Microsoft or another vendor has defined. 
Being able to define schemas is a critical business advantage. 
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By making it possible for businesses to capture the kind of information they need in a 
richer, more semantic, and structured way, Office 2003 Editions enable businesses to 
work with information in whatever way makes sense to their organization. For example, 
with Office 2003 Editions, a Human Resources system may have Word document 
resumes that are marked up with XML tags such as “name,” “address,” “career goals,” 
or “qualifications.” Once the Word documents are submitted to the system, a Human 
Resources director can run queries as rich as a database against the collection of XML 
resume files: Who has an MBA? Who speaks Polish? The Human Resources director can 
also use Excel to build charts, summary reports, and more from the data that is 
contained in those documents. 

These schemas can and often will be totally internal and unique to a company, such as 
an order-processing schema or a research report schema. But in some industries, it 
makes sense to create schemas for use among multiple companies or organizations. 
One example is XBRL, which stands for eXtensible Business Reporting Language, which is 
an open specification that uses XML schema to describe financial information. Another 
example is HL7, which is used in the healthcare industry. Having these standard schemas 
in place allows different organizations to easily share information, even if they are using 
completely different technologies from different vendors on different platforms. The 
standard schemas also create other communication and business efficiencies. 

Research task pane 

The Research task pane uses XML to provide a way for organizations to expose relevant 
internal business information and processes, and information from other relevant 
sources, directly in the context of each Office 2003 program. 

Developers within an organization can create and deploy services by using XML that 
plugs directly into the Research task pane on computers that are running Office 2003 
Editions. Services can include anything from data accessibility to interactive forms. An 
organization can also subscribe to vendor Web services that give personnel access to 
even more information in the Research pane. 

Developers can make services available to users over the Internet, through a corporate 
intranet, or by installing the services directly on a user's computer. Services that are 
available over a network, Internet, or intranet are better for information that may 
change frequently or is used by a large audience. 
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Services can be deployed manually, be discovered automatically by a user's computer, 
or pre-registered when an Office 2003 Edition is installed on a computer. With manual 
deployment, a user navigates to a URL and registers for the service. With discovery, the 
user is prompted to register for a new service automatically. When a service is pre-
registered, no user intervention is required. 

 
The Research task pane in Office 2003 Editions. 

Smart documents 

Smart documents are XML-based solution development and deployment platforms that 
are available in Word 2003 and Excel 2003. Smart documents help developers to tackle 
business-process problems by quickly building document-based solutions that combine 
the advantages of the Word and Excel desktop programs with the advantages of Web 
services. Benefits of these solutions include easier deployment and updating of the 
solution, and a larger selection of tools for solution development. 

Smart documents bring relevant information directly to the task at hand through a new 
“Programmable task pane” user interface. With smart documents, XML solutions can be 
created to enable business processes and help users complete forms and other 
documents, and then link that information to back-end systems that support XML. As 
the user clicks through the document, the program modifies itself to present the 
appropriate functions and help to complete a task. 

Smart documents can easily be incorporated into business processes such as expense 
reporting, contracts, or anything else that might pass through multiple hands or systems 
while being authored, or that require information from back-end sources. A Smart 
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Document solution can also include custom Smart Tags that are designed specifically to 
run only in that solution, or any other code that the developer would like. 

 
Smart documents use the new “Programmable task pane” shown on the right to bring relevant 
information directly to the user. 

Using smart documents makes solution deployment much more flexible. Solution code 
can now be deployed once to a central server location, and Word and Excel will securely 
download and cache it locally when the smart document is opened. Updates to the 
solution code and even the document template itself can be delivered the same way, as 
a single update to the server location for the smart document solution, without having 
to deploy directly to hundreds or thousands of clients, just as with Web-based solutions. 
But unlike Web-based programs, the Smart Document solutions can operate even when 
the computer is offline, because they use the Office programs rather than a browser. In 
addition to solutions based on the Component Object Model, smart documents also 
accept solutions that are written in Microsoft Visual Basic® 6.0, Microsoft Visual C#®, 
Microsoft Visual C++®, and Microsoft .NET managed code for additional security and 
ease of development. 

Smart documents are new, and their use is virtually unlimited. The following are a few 
example scenarios. 

• A purchase order solution using Excel might be linked to a business rule in a 
back-end server that takes the User ID and applies the user's current signing 
limit to the order directly in Excel, while the user is completing the form.  

• A social services solution could be created that translates forms into different 
languages or assists applicants in completing the form, with context-sensitive 
help.  

• Depending on the user type or ID, or on input from the user, a Word document 
could reconfigure itself to include the necessary sections that the user needs to 
complete—for example, a performance review form that has different sections 
for management and employees. 
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Programmable task panes 

Developers can create custom actions for each section of a document based on the XML 
elements of the particular document and then make the actions available to users in a 
programmable task pane. The task pane ties different controls to different parts of the 
document, revealing the most relevant services for each part while the document is 
being developed. For example, developers can build actions that display help text, ask 
for input (using standard Microsoft Windows® controls like check boxes and text fields), 
or retrieve data from other programs or back-end servers. After the user enters the data 
that is necessary for a task, the smart document can perform actions such as looking up 
data, formatting it according to the document’s template, and placing it in the 
document. 

As the user moves from section to section in the document, tasks and information that 
are relevant to a document or spreadsheet appear in the task pane, helping to 
streamline and automate what may currently be lengthy day-to-day business processes. 
The task pane gives the user control over which actions are invoked and when, such as 
manipulating data in the document, making database queries, or interacting with line-
of-business systems. 

 
A sample smart document for writing proposals. The Programmable task pane on the right is built 
to aid with the task of writing a proposal. 
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Real-time data 

In a smart document, experienced users or template and solution creators can easily 
keep their documents current by creating dynamic charts and graphs that draw on up-
to-date, real-time data from back-end systems to display business information as it 
changes, or they can create reports with up-to-the-minute information. Users can insert 
and manually refresh this data from the Research pane or from a custom solution that is 
created for the purpose. 

For example, a financial analyst writing a report can use the Research pane to locate all 
of the latest financial information about a particular organization and insert it into the 
report. Later, he or she can easily update the data to reflect any changes that occurred 
after the report was written. 

Smart tag capabilities 

As in Microsoft Office XP, smart tags in Office Professional Edition 2003 recognize 
certain words or strings as they are entered (such as a name, address, or a stock ticker) 
and allow users to choose information and actions to associate with that entry. For 
example, a user can select an action, such as turning part numbers into hyperlinks in a 
sales database, adding properly formatted citations to the end of a research paper, or 
automatically populating an index with every person, company, or product that is 
mentioned in an article. 

In Office Professional Edition 2003, smart tag support has been increased to include 
Access, PowerPoint, and Outlook. In addition, smart tag support is included in new 
features such as the Research task pane and Shared Workspaces, which are discussed in 
another chapter.  

 
A smart tag is indicated by a series of purple dots under the text. Clicking the Smart tag provides 
context-sensitive options. 

 

In Word 2003 and Excel 2003, smart tags integrate with XML support, and smart tag 
actions can be linked to XML elements in documents or spreadsheets. Word also 
extends the functionality of smart tags to apply to XML elements directly, so actions can 
be provided for entire sections of documents rather than just a few words, and actions 
can work on “types” or collections of data rather than relying on text recognition. For 
example, a custom smart tag can be written that appears on fields that require the user 
to enter data and then offers to pre-populate the data. A smart tag action can also be 
provided that applies different transforms or views on XML data that the Research task 
pane retrieves. 
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Access 2003 developers can easily embed smart tags into any Access field without extra 
programming steps. Any control on a form, report, or data page has a property for 
specifying smart tags. Any field or column on a table also has this property. The columns 
in a query inherit this property from the table that the query is based on. By embedding 
smart tags into fields, Access developers can create solutions in Access that have the 
look and feel of other Office programs. 

Users of Microsoft Office PowerPoint 2003 now can have the rich information and 
association functionality of smart tags. For example, a user could use a smart tag to add 
product details to a slide that is used during a presentation or to offer additional 
information about a new HR evaluation program or benefits package in a published 
slideshow. 

 
Smart tags are off by default in PowerPoint 2003, but can easily be enabled by the user or a 
solution. Select AutoCorrect from the Tools menu to bring up this dialog box. 
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Using smart tags in Office XP, independent software vendors (ISVs) and users have 
extended smart tags in ways that are specific to certain industries, such as facilitating 
the ability of a medical facility to look up patient records from a database by using 
names or ID numbers. Companies have also developed specialized capabilities using 
smart tags, such as the ability to display customer data based on customer ID, or show 
inventory and sell-through for a particular stock-keeping unit number. Office 
Professional Edition 2003 extends the capabilities of smart tags even further and brings 
that functionality to more programs, for the benefit of both users and developers.  

 
With the new Office Professional Edition 2003, smart tags can be attached to fields on tables, 
queries, forms, and data access pages in Access. 

XML in Word 2003 
The deep support for XML in Word 2003 creates a new metaphor for documents: 
bridging the gap between documents and data. XML in Word provides the basis for 
building solutions for a wide variety of business problems, such as consistent forms and 
reports, data reporting, content aggregation, publishing, data mining, and data 
submittal to business processes.  

Benefits for structured documents and content authoring 

An efficient method of streamlining business processes is the implementation of 
standard tools across departments, including forms and reports. To support this goal, 
Word 2003 includes the ability to limit the formatting that can be used in a document, 
and to limit the parts of a document a user or users can edit. In this way, Word can be 
used as a data input tool for XML-based business processes. 

For example, with a financial services template, the creator of the template can lock the 
parts of the document that explain how to fill it out, and can even limit the kinds of 
formatting the user can apply. After the customer completes the rich Word document 
within these enforced guidelines, it can be submitted to a Web service or internal server 
tool that collates the information the user submitted, because the data is pure, valid, 
well formed XML, which means that other business systems can use it easily. 
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Capabilities and benefits 

Much of an organization’s knowledge lies in documents that are created by individuals 
in the organization, and those documents are generally stored where access is relatively 
difficult for anyone other than the creator of the document. Predictions about exactly 
which bits of information are going to be valuable in the future are also difficult. When 
documents are stored as XML files, this information can be “mined” at a later date as 
appropriate. For example, a user could pull all of the graduation dates out of a collection 
of resumes in a particular XML schema with a simple query. Doing this with HTML or 
normal word processing documents (in binary or native XML without customer-defined 
schemas) would be difficult if not impossible. 

In addition to the support for customer-defined schemas in the professional edition, all 
editions of Word 2003 provide a native XML file format—a valid, well-formed XML file 
that fully represents a Word document. With Word 2003, users can save resumes, 
reports, or other documents as XML files and retain all of Word’s rich formatting when 
the file is opened again. No features or formatting are lost when saving a Word 
document as XML, and only a single file is created. This makes it much easier to share or 
work with the document than with the HTML format, where images and other files are 
stored separately.  

To maximize the usefulness of a document, one document often appears in different 
contexts or on different devices. For example, a company’s annual report might go out 
to shareholders in a rich printed form, be available from their Web site in a simpler form 
that works with all Web browsers, and even be available for display on devices with 
small screens, such as Pocket PCs. 

Word 2003 defaults to saving in the *.doc binary format, which can be read by over 300 
million Word users worldwide. Word can be configured to default to any of several 
other formats, either through corporate policy or by end-user choices. An option that 
exists in Tools/Options/Save forces Word to always save in XML, for example. Further, a 
solution builder can control Word so that it always saves as XML to a content repository, 
but allows the end user to save as *.doc locally, if that is what the user prefers. 

The Word XML file format is useful in itself as a way to enable access to the content of 
documents without requiring Word (such as when WordML documents are stored on a 
server and the server needs to query the document content). In addition, a significant 
part of its value is to act as a container for the customer-defined schema data. When 
using a customer-defined schema, the Word XML acts as a transparent “envelope” that 
carries the more valuable customer data, providing information about how it should be 
presented (for example, formatted in a table). When used with customer-defined XML 
data, Word XML also adds the capability to execute complex operations on customer 
data, such as merging two XML documents and storing the differences, or tracking 
changes on XML data as it is modified by multiple users–capabilities that are simply not 
available today in other products. 
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Using Word 2003, users can open a pre-existing, customer-defined XML file while 
retaining the file’s own schema, or can create a new file by applying an XML schema to 
an existing Word document or template. Word also allows users to see the XML 
elements that have been applied to a document, along with a list of elements that can 
be applied to the current selection. This list is taken from the schema that has been 
applied to the document. By default, it shows only those elements that are valid 
according to the schema in the selected context.  

Word’s support for customer-defined schemas allows the customer’s data to remain in 
the document while it is edited, and to be extracted later on. This is much more 
powerful than a method where the customer data is transformed into formatting or 
styles in a document. Word 2003 also supports the use of XSL Transforms (XSLTs) for 
converting files. 

Users can employ XSLTs to produce multiple formats from one master XML copy of the 
document. The advantage of this approach is that users do not need to make edits in 
multiple copies of the document. Instead, a Web server can use different transforms on 
the master XML document depending on the viewing device, so the user simply edits 
the master and lets the transform take care of the appropriate presentation. Similarly, 
the XSLT can be changed in order to change the appearance of the document without 
having to worry about introducing errors into the original. The user can also manually 
create the different versions by simply doing a Save As “through” the different XSLTs. 

A document that uses a customer-defined schema (from an XSD) can be saved in one of 
the following ways: 

• In XML using only that schema (no Word XML included) this is considered “pure 
data.” 

• A WordML file with the customer-defined XML interspersed, yet clearly 
separated by using XML namespaces. The WordML can be easily removed 
through a transform or programmatically at any time, leaving only the XML in 
the original schema for easy manipulation by outside processes, such as a server 
mining the document for data. 

• XML markup also conveniently persists in the binary *.doc and *.dot formats for 
easy transport and storage, as well as to provide a document that can be 
opened, viewed, and edited in older versions of Word (although the customer-
defined XML will be lost if the document is changed and saved). 
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An advanced Word user marking up a template with the user's own XML schema. The tag view is 
turned on and the XML structure pane is visible. Later on, a consumer of this template would not 
see any tags or the XML structure pane, but would simply fill out the template normally and see 
the appropriate markup on the content. 

 

In addition, Word 2003 will automatically detect associations among XML files and 
schema files (XSDs), and give users the option to attach the appropriate XSDs or use 
applicable XSLTs when it encounters XML files that belong to categories that are 
registered with Word, such as news articles or resumes. With this feature, a user can 
simply open an XML file, and Word will automatically apply an XSL Transform to display 
it in an organization’s standard format if an association has already been made.  
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For reporting data, Word 2003 supports refreshable XML web queries. The results of the 
queries can be passed through an XSL Transform for display in Word using its rich 
formatting capabilities. Users can take advantage of this capability to present, inside a 
weekly report or other document data such as server-side SharePoint data (available as 
XML from SharePoint), other XML data from any Web service or database, ASP/ASPX 
pages, or other sources. For example, a user can include a table in a document that 
shows the current status of the document on a SharePoint site, the author, priority, due 
date, and more, and this information can be updated automatically to keep it in sync 
with any changes on the server. 

By making it so easy to work with XML files, Word 2003 can now become an integral 
part of an organization’s content-management solution. Users can create XML content 
by using the familiar Word program. Word’s task pane can also show fragments of XML 
documents that can be recombined or inserted into the current document to simplify 
the reuse of content across the organization. Developers can easily create solutions to 
manipulate, distribute and repurpose this content as needed by using tools such as 
Visual Basic for Applications (VBA) or even Visual Studio .NET Tools for Office and the 
robust Word XML object model. 

XML in Excel 2003 
In the previous version of Excel (Excel 2002), users who wanted to work with XML had a 
great tool using the XML Spreadsheet (XMLSS) format. Excel 2003 has built on that initial 
XML experience and is now able to consume and generate XML data files expressed in 
customer-defined XML schemas (XSDs), not just in the XML Spreadsheet format. Excel is 
now an efficient XML data analyzer, editor, and viewer; expanding the ability to analyze, 
display, and insert up-to-the-second business information. 

Advantages for sharing business data 

The support for XML in Excel 2003 opens a wide range of possibilities for processing 
data from an Excel file in other programs. For example, an expense report solution could 
be created that consists of an Excel spreadsheet template mapped to an organization’s 
XML schema for expense reports. After entering data in Excel and producing an XML file 
matching the expense report schema, that data could easily be consumed by the 
company’s SAP accounting system—or any other back-end system or platform that 
supports XML—for processing. The XML capabilities of Excel unlock this information so 
that it can be used across multiple disparate systems within heterogeneous 
environments. 
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Capabilities and benefits 

To simplify the process of sharing data across programs from within an Excel file, 
support for customer-defined XSDs make it easier for users to add structure to their 
data and to map data easily from external XML sources into an Excel workbook. 

Excel now allows users to add structure around data that they track in spreadsheets. 
The List feature and its XML overlay provide a data entry row at the bottom of the list 
that automatically expands the list region as new items are entered. The Toggle Total 
Row feature turns on a total row where the user can specify average, count, count 
numbers, maximum, minimum, summation, standard deviation, or variance for the 
values in any of the list's columns. In addition, when data is in an Excel list, operations 
such as printing, charting, or creating a PivotTable are easier to perform. 

 
New List features in Excel help users arrange and analyze listed data.  

 

 
To import XML data, use the refresh and import buttons on the List and XML toolbar. 
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For importing data from other XML sources, Excel 2003 provides a user-friendly visual 
mapping tool that works much like a field chooser. With it, Office solution developers 
and even power users can do the following tasks, without writing any code: 

• Easily map existing Excel spreadsheets to XML data structures such as databases 
for import 

• Create dynamic Excel documents that load XML data, display it and write it back 
out in the same XML vocabulary with up-to-the-minute information 

• Create new XML-enabled information repositories from existing Excel 
spreadsheets 

Using the mapping tool to pull from data sources such as a back-end XML-enabled 
server, a Web service, or any XML data file, users can arrange information on the Excel 
grid and display it in any format they want. Simply clicking Refresh updates the 
spreadsheet, so up-to-date information is available for even the fastest-moving data. 

 
The new visual mapping tool for XML in Excel 2003 works much like a field chooser. With it, Office 
solution developers and even power users can now build a dynamic information structure into an 
existing spreadsheet, graph, or chart, using XML data as calculation inputs to the document. The 
tool makes this possible without writing any code. 



  

 
 
 

103 

XML in Access 2003 
XML support in Access 2003 has been dramatically improved, offering a powerful tool 
for exchanging data between Access 2003 databases and between Access 2003 and 
external sources. The Access 2003 XML enhancements include exporting several related 
tables at once, importing or exporting the published 2001 XSD namespace, applying an 
XSLT on export or import, exporting presentation XSLs, and enabling all of these 
enhancements programmatically.  

Benefits for reporting and storing numerical or textual data 

XML support in Access 2003 makes it an ideal solution for reporting and storing data. 
This is enabled by enhanced XML export and import options. 

The basic export options allow data to be exported as pure XML, the schema of that 
data to be exported as XSD, and/or an HTML presentation of the data to be exported as 
an XSLT. Additional export options provide detailed control of the export, including how 
much data to export, which records to export, transform options, and schema options. 

The new import options make Access 2003 an ideal storage location for vital business 
information. During import, the structure of the XML data is presented in the Import 
dialog box. A registered custom XSLT can be applied to restructure data to fit the 
database, and new XML data from external sources can now be appended to existing 
tables. 

Capabilities and benefits 

Importing and exporting XML files is far more flexible with Access 2003 than with 
previous versions of the program. With Access 2003, users can work with XML files of 
any schema and import them into the existing structure of an Access 2003 database by 
applying an XSL Transform (XSLT) that they or another developer created.  

In previous versions of Access, data had to be restructured for a database before it 
could be imported; in Access 2003 a user can apply a custom registered XSLT during 
import so that the data is restructured during the import process. When a transform has 
been specified, it is added to a list of transforms that Access remembers so that they can 
easily be applied in the future. 

When importing an XML file from an external source or another Access 2003 database, 
the user can choose to create new tables or append existing tables. Basic import options 
are to import structure only, structure and data, or append data.  

The export options enable users to apply an XSLT during export, and as a result convert 
the Access generated XML into any file format that the XSLT whishes to generate. For 
example, a user can export data and use an XSLT that generates a Word 2003 file, 
including images, proper word wrapping, and any other Word feature. 

The ability to apply transforms on import and export allow users within an organization 
or different organizations to easily share information. XML files can easily be converted 
to and from other XML schemas via transforms. 

Additional new export options allow users to select how much of a database to export, 
to decide whether or not to apply an existing sort, and which records to export. For 
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example, a user can choose to export a single record from a database with or without 
related data, or all of the data in a database. The user can also choose to apply existing 
filters or sorts to the exported data.  

 
The Export feature in Access 2003 can be used to output just the XML data that is associated with 
the current record, all records, or filtered data—if a filter is applied—in a table. The Lookup Data 
options allow Access to export the related lookup data for the records as well, for a complete 
representation of the information. 

Access 2003 also provides improved support for exporting data for an HTML 
presentation, making data easier to publish to the Web. Furthermore, XSLTs are 
generated, sorting and grouping have been improved, and running sums, hyperlinks, 
and expressions in sorting and grouping are available. 

In addition to the user interface capabilities that are bolstered by improved XML 
support, all of the following XML features are available to developers through the 
Access object model: 

• Application.ExportXML 
• AcExportXMLOtherFlags 
• Application.CreateAdditionalData 
• AdditionalData Object 
• Application.ImportXML 
• Application.TransformXML 
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Summary 
Support for XML in Office Professional Edition 2003 simplifies business processes by making 
information accessible in multiple formats and in multiple programs. By enabling user-defined 
XSDs and XSLTs, organizations can also customize data output to meet their specific needs. With 
the added benefits and features of XML, Office Professional Edition 2003 can be the premier 
choice for businesses. 

 



5 Help and Office Online  
Services 
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Online help and training 
Office 2003 Editions offer new and improved integration with Microsoft Office Online Web 
services. More powerful, better integrated, and with an improved online interface, these 
services are seamlessly available from within Office 2003 programs. The website, also available 
through a browser at www.microsoft.com/office, offers a resource page for each Office 2003 
Editions program. The resources pages have assistance, columns, training, and templates. 

Help 
The Help system of Microsoft® Office 2003 Editions has been extended beyond 
individual workstations. If a user is connected to the Internet when choosing a Help 
topic or entering a word in the Ask-A-Question box, the Help system displays not only 
the help information from the local system, but also brings to the Help window 
information from the Microsoft Web site (www.microsoft.com). This provides the most 
current information on the topic that the user needs help with, in addition to links to 
other resources. 

Assistance 
The Assistance Web page provides up-to-date information with How To articles, 
conceptual topics, columns, and helpful tips for common tasks. Users can find answers 
to common questions, read articles on features in Office 2003 Editions, look for specific 
help in newsgroups, or suggest a topic for a future article. 
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Training on Office Online 
The Training site offers Web-based interactive training courses and self-paced exercises. 
Users can develop deeper knowledge of tasks and application features, such as creating 
an outline in Microsoft Office Word 2003 or using motion paths in Microsoft Office 
PowerPoint® 2003 slides. Courses include practice sessions where users can give things 
a try in the actual program, and short tests to assess comprehension. Courses cover a 
variety of topics, and are available for any Office 2003 Editions program. 

 
Use Office Online to find training opportunities for Office programs. 

Downloads 
On the Downloads site (formerly known as Office Update), users can check for free 
updates that improve the stability and security of Office 2003 Editions. On the 
Downloads home page, users can click the "Check for Updates" button to start the 
automatic detection tool, which scans the computer and then returns a list of new 
downloads that are available and compatible with the user's version of Office. In 
addition to security and performance updates, viewers, converters, add-ins, stationery, 
and other useful downloads are also available. The most popular downloads are listed in 
the Popular Office Downloads section. 
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Accessibility features 
Office 2003 Editions provide new and improved features for accessibility. The following are 
some of the new accessibility features:  

• Keyboard shortcuts for using the Help task pane and Help window 
• Keyboard shortcuts for using the "Ask a Question" box 
• Options to change the appearance of a Help topic by altering the background or color 
Specific to Word 2003 are keyboard shortcuts for customization options, and tips for working 
more efficiently. For Microsoft Office Access 2003, developers and users who create and edit 
Microsoft SQL Server™ queries can control the font size of the text in the SQL Server window. 
This feature is one that users have been requesting since the first version of Access was 
released.  

For more information about accessibility, go to www.microsoft.com/enable. 

Clip Art and Media Web site 
The new Clip Art and Media Web site offers thousands of Clip Art pieces and media selections to 
brighten up documents. Users can now perform multiple word searches by using the improved 
Clip Art Search function. In addition, all clips and media are arranged in a variety of categories 
for quick and easy browsing. Some examples of categories include Arts, Business, Food, Leisure, 
and Technology. The Featured Collections section of the Web site offers specially selected 
categories.  

 
Perform searches for clipart and media by keyword or category. 
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To select a file for download, users can add it to the basket. Similar to an online shopping 
basket, all of the Clip Art selections are displayed in the basket and users can view its contents at 
any time. The basket displays the total number of clips accumulated, file size, and approximate 
download time for each clip. Users can download all of the clips in the shopping basket at one 
time by clicking the "Download Now" button. 

As an alternative to using the basket, users can click the "Download the clip of the day" link to 
download the featured clip. Users can also drag the clip of the day, or any clip, directly onto an 
Office document. In addition, Popular Collections are categorized for easy navigation in the side 
pane. Some sample collections include Business Photos, Travel Photos, Birthday Clips, and Office 
Sounds. 

 
Use the shopping basket to sort clipart and media and download only those you really want. 
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Templates on Office Online 
Templates help to optimize productivity by providing timesaving documents that are useful for 
simple and complex tasks. The improved Templates site (formerly known as the "Template 
Gallery") offers hundreds of templates to choose from, for business use and for fun. The new 
design of the Templates site includes a simplified user interface organized into clear-cut 
categories that users can easily navigate.  

 
Find the best template quickly and easily with the improved organization of the Templates site. 
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The available templates are organized into logical categories for easy browsing. Categories 
include Calendars and Planners, Finance and Accounting, Travel and Maps, Meetings and 
Projects, and many more.  

When users select a template to view, they can see the size of the template, approximate 
download time, and any additional system requirements that are necessary (if applicable). With 
one simple click, a user can download and open the template in the appropriate Office 2003 
Editions program. 

 
See file size and download time before making a decision to download templates. 

 

Similar in format to the Clip Art and Media Web site, the Templates site includes a place where 
users can provide feedback, make suggestions for a template style, or opt to get the newsletter. 
The list of Quick Links is also the same across the Office Online sites—Calendars and Planners, 
Business Animation, Data Analysis Tools, Live Support Providers, and more.
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Whether you're a student, small business owner, or a volume-license business customer, 
Microsoft has an Office 2003 Edition that's right for you. Use the following table to learn what 
Microsoft Office System products and technologies will be included in each edition. 

 

 

Student  
and Teacher 

Edition* 
(retail only) 

Standard 
Edition 

Small Business 
Edition 

Professional 
Edition 

Professional 
Edition  

(volume 
licensing only) 

Create professional and effective 
documents by using Word 

ü ü ü ü ü 

Access, analyze, and display data 
with Excel spreadsheets 

ü ü ü ü ü 

Deliver your ideas powerfully 
with PowerPoint presentations 

ü ü ü ü ü 

Manage your e-mail, calendar, 
and tasks effectively by using 

Outlook 

ü ü ü ü ü 

Manage customer relationships 
with Business Contact Manager 

for Outlook  

  ü ü ü 

Create impressive sales and 
marketing materials with 

Publisher 

  ü ü ü 

Build powerful, customizable 
database solutions with Access 

   ü ü 

Exchange data with other 
systems using enhanced support 

for XML technology 

   ü ü 

Create IRM protected 
documents and e-mails that help 

reduce unintentional sharing of 
sensitive information. 

   ü ü 

Create easy-to-use forms, gather 
information more effectively, 

and collaborate with InfoPath 

    ü 

*  You must be a “Qualified Education User” to license this software. Please review the qualifying criteria at 
www.microsoft.com/office/eula 

For more information on how to purchase, please go to http://www.microsoft.com/office 
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Index of new functionality 
Microsoft Office 2003 Editions 

Creating a Document Workspace 
Information Rights Management (IRM) 
XML 

Outlook 2003 
Reading Pane 
Multi-line message view with smart dates and grouping 
Arrange by conversation 
Go menu 
Quick flags 
For Follow Up folder 
Search Folders 
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XML Glossary 
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Microsoft Office 2003 Editions 
Microsoft® Office 2003 Editions offers several new features to its users. These new features are 
individually described within the following sections. 

Creating a Document Workspace 
Document Workspace sites make everyday document collaboration easier in several 
ways. By using a Microsoft Windows® SharePoint™ Services site, all of the task lists, 
deadlines, related documents, hyperlinks, and contacts for project participants are 
centralized. The sites also integrate with Office 2003 Editions programs through the 
Shared Workspace task pane in the program. Each user can see the incremental 
progress in task completion. 

Users can create a Document Workspace site for any Office document on a workstation. 
This document becomes a connected local copy of the document, and a master copy is 
kept on the server. Users can then invite other contributors to work in the Document 
Workspace, add links, and more. 

 
Facilitate collaboration by creating a document workspace. 

How to create a Document Workspace 

1. On the Tools menu, click Shared Workspace.  

2. In the Shared Workspace task pane, click or type the Web address (URL) of a 
Windows SharePoint Services Web site where the Document Workspace will be 
located.  

3. Click Create.   
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In Microsoft Office Outlook 2003®, when an Office document is attached to an e-mail 
message, the Attachment Options task pane appears. By default, the attachment is sent 
in the same way as in the past, but the user also has the option to store the document in 
a Document Workspace. Users can specify the SharePoint site on which to create the 
Document Workspace, or use the default choice.  

 
Store a document in a Document Workspace by saving the attachment as a shared attachment. 

 

How to create a document workspace when you send a shared attachment 

In Outlook 2003, start a new e-mail message and attach a document to the message.  

-or- 

1. Open the attached document, click File, click Send to, and click Mail Recipient (as 
Attachment). 

2. If the Attachment Options task pane is not visible, click Attachment Options. 
3. Click Shared attachments. 
4. In the Create Document Workspace at box, click or type the Web address (URL) of a 

Windows SharePoint Services Web site where the Document Workspace site will be 
located. 
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Information Rights Management (IRM) 
IRM is a new policy-enforcement technology that continually helps to protect sensitive 
documents and e-mail messages from unauthorized use. Because the access and usage 
restrictions are enforced no matter where the information is, a user can protect a 
document or e-mail and then share it or send it in e-mail while maintaining more control 
over who can use it and what they use it for. 

IRM can also help to prevent e-mail forwarding, copying, or printing. Protected 
messages are automatically encrypted during transit. When the sender applies 
restrictions, Outlook 2003 disables the reuse commands when the message is received. 
Office documents that are attached to protected messages are also automatically 
protected. 

In Microsoft Office Word 2003, Microsoft Office Excel 2003, and Microsoft Office 
PowerPoint® 2003, users can help protect documents on a per-user or per-group basis. 
Each user or group has a set of permissions according to the defined roles: Viewer, 
Reviewer, or Editor. Users can also prevent printing and set expiration dates. After 
expiration, documents cannot be opened. 

 
With IRM, users control who can view, review, or edit documents. 

 

How to send an e-mail message with restricted permission in Outlook 2003 

1. Open a new mail message and fill in the To, Cc, Bcc, and Subject fields. 
2. Type your message. 

3. On the E-mail toolbar, click Permission .  
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How to set IRM in Word 2003, Excel 2003, and PowerPoint 2003 

1. On the File menu, point to Permission, and then click Do Not Distribute.  
2. In the Permission dialog box, select the Restrict permission to this <file type> check 

box.  
3. In the Read and Change boxes, type the names or e-mail addresses of people you 

want have permissions.   

XML 
Office 2003 Editions enhance XML support in existing Office programs and introduces 
new XML programs. When creating reports, spreadsheets, and forms with an attendant 
XML schema, users build documents that recognize the structure and meaning of the 
content within those documents and respond intelligently (for example, by validating 
information as it is input and avoiding errors). The following are examples of XML use in 
Office 2003 Editions: 

• With Microsoft Office Access 2003, users can work with XML files of any schema 
and import them into the existing structure of an Access database, or continue 
to use an XSL Transform (XSLT). 

• In Excel 2003, users can map existing Excel spreadsheets to XML data structures 
such as databases for import, create dynamic Excel documents that load XML 
data and write it back out in any format, and create new XML-enabled 
information repositories from existing Excel spreadsheets. 

• Word 2003 provides a native XML file format—a valid, well-formed XML file that 
fully represents a Word document. With Word 2003, users can create XML using 
the XML Structure pane, and then save resumes, reports, or other documents as 
XML files while retaining the rich formatting of Word when the file is opened 
again. 
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Word 2003 provides a native XML file format that fully represents a Word document. 

 

How to view XML tags in a Word document 

Press CTRL+SHIFT+X. 
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Outlook 2003 
Outlook 2003 offers several new features to its users. These new features are 
individually described within the following sections. 

Reading Pane 
Using the Reading Pane reduces eyestrain and makes time spent reading e-mail 
messages more efficient by showing more of the message on the screen. The Reading 
Pane reduces scrolling and minimizes the need to open and manage many separate 
windows for different e-mail messages. 

 
More of the message is visible with the Reading Pane. 

How to use the Reading Pane 
To change the Reading Pane options: 
1. On the Tools menu, click Options,  
2. Click the Other tab. 
3. Click Reading Pane. 
 

To change the location of the Reading Pane: 

1. On the View menu, point to Reading Pane.  
2. Click Right or Bottom. 
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To hide the message header: 
1. On the View menu, point to Arrange By, click Custom, and then click Other Settings.  
2. Under Reading Pane, select the Hide header information check box. 
 

Multi-line message view with smart dates and grouping 
Organizing messages is easier with Outlook 2003. The Multi-line view puts the sender’s 
name in dark text in the upper-left corner, making it easy to scan down the list for 
important names. Secondary information is rendered in lighter shades of text to draw 
the eye towards the more important information. This view also makes messages easier 
to select with the pen on a Tablet PC. 

To use space more efficiently, Smart Dates change the date format on the fly based on 
how long ago the message was received. For example, an e-mail message that was 
received today will only display a time: 3:40 p.m. Messages that were received during 
the current week display a day of the week and time: Wed 1:24 a.m. For e-mail that was 
received many months ago, the exact time is less important, so Outlook 2003 displays 
only the date: 1/12/2003. This makes it easier for the user to sort, find, file, and manage 
e-mail quickly and efficiently. 

The new e-mail view automatically applies intelligent groupings to help sort messages. 
For example, when messages are arranged by date received, Outlook 2003 splits them 
into simple groups (“Today,” “Yesterday,” “Last Week,” “Last Month,” and so on). When 
messages are arranged by size, Outlook 2003 again divides messages into user-friendly 
groups (“Large,” “Small,” “Very Large,” and so on). These groups make it easier to scan 
through a list of several messages.  

Users can treat these groups as objects, choosing to move, delete, copy, forward, or 
perform other actions on all items in the group at one time. For example, messages can 
be grouped by date, and then the user can drag all of the messages from “Last Month” 
to another folder, filing them away with one click.  

 



 

 
 
 

122 

 
Users can specify the number of lines that display in multi-line view. 

 

How to change multi-line view settings 

To change the number of characters displayed before multi-line layout switches to 
single-line layout: 

1. On the View menu, point to Arrange By, and then click Custom.  
2. Click Other Settings.  
3. Under Other Options, select the Use multi-line layout in widths smaller than n 

characters check box, and type the number you want for n.  
 
To specify the number of lines that display in multi-line view: 

1. On the View menu, point to Arrange By, and then click Custom.  
2. Click Fields.  
3. In the Maximum number of lines in multi-line mode box, select the number you 

want. 
 



 

 
 
 

123 

 
When users rearrange e-mail messages, Outlook 2003 groups them into logical units. 

 

How to apply intelligent grouping 

1. On the View menu, point to Arrange By, and then select the appropriate 
arrangement.  

2. To customize the arrangement that has been applied, on the View menu, point to 
Arrange By, click Custom, and then select the appropriate options. 
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Arrange by conversation 
This feature groups messages by message subject or “thread.” The sorting order of 
items in the “threads” is based on who replied to whom, and the sorting order of the 
groups is by date. When a new message is received, the entire conversation to which it 
pertains moves to the top of the message list. By default, only unread and flagged 
messages appear. Users can see all messages in the conversation by clicking the arrow 
that appears next to the conversation heading. Messages are indented to show who 
replied to whom and when the reply was sent. 

  
Arrange e-mail messages by conversation to sort by subject or thread. 

 

How to arrange by conversation 

1. On the View menu, point to Arrange By, and then click Conversation.  
2. To customize the arrangement, on the View menu, point to Arrange By, click 

Custom, and then select the appropriate options. 
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Go menu 
To move between the different Navigation Pane module views quickly, users can use the 
Go menu or the integrated keyboard shortcuts. The following are keyboard shortcuts: 

• Mail  CTRL+1 
• Calendar CTRL+2 
• Contacts CTRL+3 
• Tasks  CTRL+4 
• Notes  CTRL+5 
• Folder List CTRL+6 
• Shortcuts CTRL+7 
• Folder  CTRL+Y 
 

 
Navigate between the different modules by using the Go menu or keyboard shortcuts. 

 

How to navigate using the Go menu 

On the Go menu, click the appropriate Navigation Pane module or view. 
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Quick flags 
Use this feature to mark messages with a flag for follow-up action or later reference. 
Flagging a message, meeting request, or contact adds a flag icon to the item. Use the six 
colored message flags to manage incoming e-mail items by flagging the items for 
different kinds of follow-up action. 

When users add a message flag, the background color of the Flag Status column changes 
color, making it easy for users to find items in the message list while scrolling. Items to 
which a message flag is added automatically appear in the For Follow Up Search Folder. 

 
Use the colored message flags to flag items for different kinds of follow-up action. 

 

How to flag an e-mail message 

1. Click the flag icon on an e-mail message to flag it with the default flag.  
2. To flag the message with a different colored flag, or to change the default flag color, 

right-click the flag icon, and then click the appropriate option. 

For Follow Up folder 
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Any message, meeting request, or contact that has been flagged is visible in the For 
Follow Up Search Folder. Because it is a Search Folder, the items remain in their original 
Outlook locations. Items are grouped by the type of follow-up action they require, which 
is indicated by the color of the message flag. Use this folder to group and browse items 
that are intended for follow-up action or further reference.  

 

 
The For Follow Up Search folder contains a view of all items that have been flagged. 

 

How to view the For Follow Up Search folder 

1. Make sure that at least one message, meeting request, or contact has been flagged.  
2. In Mail, in the Favorite Folders area, click For Follow Up. 
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Search Folders 
Search Folders are virtual folders that contain views of all e-mail items matching specific 
search criteria. Search Folders contain the results of previously defined search queries, 
but all e-mail items remain in their original Outlook folder. With Search Folders, users 
can easily group and browse through all items relating to a subject, person, task, or 
other criteria, without physically moving messages or folders. 

Three Search Folders are created for users by default: 

• Unread Mail. All unread e-mail items appear in the Unread Mail Search Folder.  
• For Follow Up. Any e-mail message that includes a flag appears in the “For 

Follow Up” Search Folder. 
• Large Mail. E-mail items that are larger than 100 kilobytes (KB) appear in the 

Large Mail Search Folder. 
These three default Search Folders can be modified or deleted. 

 
Use Search Folders to group and browse through all items that relate to a subject. 
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How to create a new Search Folder 

1. In Mail, on the File menu, point to New, and then click Search Folder.  
2. Use a predefined Search Folder or click Create a custom Search Folder. 

New mail Desktop Alert 
In Outlook 2003, the new mail Desktop Alert fades into view with the name, subject, 
and a short text preview of the new e-mail message. When a Desktop Alert appears, 
users can set a flag on a message, delete it, or mark it as read—all without opening the 
Inbox. If the Desktop Alert is ignored, it soon fades from view. 

Users can customize the appearance of the Desktop Alerts. The alerts can remain visible 
for as briefly as three seconds or for as long as 30 seconds. Users can also adjust the 
transparency to make the alerts more noticeable or to keep them from blocking the 
view of documents and other items on the desktop. Users can also change where the 
Desktop Alerts appear by dragging an alert to a more preferable location on the 
desktop. 

 
Customize the transparency and duration of the Desktop Alerts. 

 

How to customize Desktop Alerts 

1. On the Tools menu, click Options.  
2. On the Preferences tab, click E-Mail Options, click Advanced E-mail Options, and 

then click Desktop Alert Settings. 
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Junk e-mail settings 
Outlook 2003 includes features that are designed to help prevent much of the 
unwanted e-mail that arrives every day, and to give the user control over the kinds of 
messages that can be received. The features include the following options: 

• Junk E-mail Filter. The Junk E-mail Filter feature is on by default, and the 
protection level is set to Low, which is designed to catch the most obvious junk 
e-mail messages. Any message that Junk E-mail Filter catches is moved to a 
special Junk E-mail folder, where users can retrieve or review it at a later time. 
Outlook 2003 can also be set to delete junk e-mail messages permanently. 

• Safe Senders List. If an e-mail message is mistakenly marked as junk by the 
filter, the user can add the sender of that message to the Safe Senders List.  
E-mail addresses and domain names on the Safe Senders List are never treated 
as junk e-mail, regardless of the content of the message. 

• Blocked Senders List. E-mail messages from certain e-mail addresses or domain 
names can easily be blocked by simply adding the sender to the Blocked Senders 
List. Mail from people or domain names on this list are always treated as junk, 
regardless of the content of the message. 

• Safe Recipients List. A mailing list can also be added to the Safe Recipients List. 
Any e-mail that is sent to e-mail addresses or domain names on this list will not 
be treated as junk, regardless of the content of the message. 

• AutoUpdate. Microsoft is committed to providing periodic updates of the Junk 
E-mail Filter so that it continues to be effective. 
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Use the junk e-mail settings to set the appropriate level of protection, and to add to the Safe 
Senders, Safe Recipients, and Blocked Senders lists. 

 

How to change the junk e-mail settings 

1. On the Tools menu, click Options.  
2. On the Preferences tab, click Junk E-mail.  
3. Click the Options, Safe Senders, Safe Recipients, or Blocked Senders tab to modify 

the desired settings. 
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Block external content 
Messages that are formatted in HTML often contain images that are not included in the 
message itself, but are instead downloaded from a Web server when the e-mail 
message is opened. These unannounced connections to Web servers can now be 
blocked.  

If an e-mail message tries to connect unannounced to a Web server on the Internet, 
Outlook 2003 blocks that connection until the user decides to view the content. 
However, e-mail messages from or to e-mail addresses or domain names on the Safe 
Senders and Safe Recipients Lists are treated as exceptions, and the blocked content will 
be downloaded. Users can download pictures and other content on a per-message basis 
by clicking the InfoBar or by right-clicking a blocked image, or can change the settings 
about automatic picture download for all HTML messages. 

 
When an e-mail message attempts to download pictures from a Web server, the pictures are 
blocked. Users can download them on a per-message basis, or change the settings. 

 

How to change the Block External Content settings 

1. On the Tools menu, click Options, and then click the Security tab.  
2. In the Download Pictures area, click Change Download Settings. 
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Shared calendar 
Users can quickly view another person's calendar, contacts, and tasks from the 
Navigation Pane. After the first time a user gains access to another person's folder, the 
shared folder is added to the Navigation Pane. The next time the user wants to view the 
other person's folder, the user can select it in the Navigation Pane. Likewise, users can 
share their own calendar with anyone or with only a specified group. In either case, the 
details of any item that is marked Private are not displayed to other people. 

 
Users can specify if they want to share their calendars. 

How to share a calendar 

In Calendar, click Share My Calendar. 

How to view another person’s shared calendar 

1. In Calendar, click Open a Shared Calendar. 
2. To select another person's name from the address book, click Name or type the 

name in the Name box. The new calendar will appear to the side of any calendar 
already in the view. 

Contact picture 
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With Outlook 2003, pictures can be added directly into a contact, which means that 
users can associate a face with the name and other information in the contact. 

 
When a picture is added to a contact, a name is associated with a face. 

 

How to add a picture to a contact 

1. In Contacts, create or open a contact.  
2. On the Actions menu, click Add Picture. 
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Cached Exchange Mode 
In Cached Exchange Mode, a copy of a mailbox is stored on the computer, and the mail 
server updates the data frequently. If the user is working offline, whether by choice or 
as a result of a connection problem, the data is still available instantly. 

 
Cached Exchange Mode stores a copy of the user's mailbox for offline availability. 

 

How to turn Cached Exchange Mode on or off 

1. On the Tools menu, click E-Mail Accounts,  
2. Click View or change existing e-mail accounts, and then click Next.  
3. In the Outlook processes e-mail for these accounts in the following order list, click 

Microsoft Exchange Server, and then click Change.  
4. Under Microsoft Exchange Server, select or clear the Use Cached Exchange Mode 

check box. 
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Remote Procedure Calls (RPC) over Hypertext Transport Protocols 
(HTTP) 
With Outlook 2003 and Microsoft Exchange Server 2003 running on Microsoft Windows 
Server 2003, users can gain access to the Exchange Server-based computer directly by 
way of HTTP over an Internet connection. With Outlook 2003, if users can browse the 
Web, they can use the Exchange mailbox. 

Outlook 2003 automatically connects by way of HTTP when a direct connection to the 
Exchange Server-based computer is unavailable, eliminating the need to have corporate 
VPN servers set up for e-mail access. 

 
Office administrators can configure Outlook 2003 to communicate with an Exchange server over 
the Internet. 

 

How to connect to the Exchange server by using HTTP 

1. On the Tools menu, click E-mail accounts, and then select View or change existing e-
mail accounts. 

2. Click Next. 
3. Select the Microsoft Exchange e-mail account, and then click Change.  
4. Click More Settings, and then click the Connection tab.  
5. Select the connection you use when working offline. 
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Internet faxing 
Outlook 2003 integrates Internet faxing. This integration allows the users to send faxes 
by using features that a typical fax machine does not offer. For example, users can use 
the fax numbers in Contacts, use the preview tool to view a fax before sending it, 
calculate the cost of the fax before sending it, add cover pages that are fully editable in 
Word 2003, and even sign their names on their fax if they use a Tablet PC. Users can not 
only send faxes with Outlook 2003, but also receive faxes in their Outlook Inboxes. 

 
With Internet faxing, users save on long-distance phone bills and keep phone lines free. 

 

How to send a fax 

On the File menu, point to New, and then click Internet Fax.  
An e-mail message opens in Outlook 2003 with the document attached as a .TIF (image) 
file, or a file can be attached to the message. 
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Word 2003 
Word 2003 offers several new features to its users. These new features are individually 
described within the following sections. 

ClearType 
Reading Layout view and Print Layout view use Microsoft ClearType® to display type in 
Word 2003. ClearType is a typographical technology that is ideal for portable computer 
monitors and other flat-screen monitors. With ClearType, text may appear slightly blurry 
on older desktop-computer monitors. If users are working with a flat-screen monitor, 
they will need to ensure that ClearType is enabled in Windows. 

 
The clarity and sharpness of ClearType is ideal for portable computer monitors and other flat-
screen monitors. 

 

How to enable ClearType in Windows XP 

1. In Windows Control Panel, click Appearance and Themes, and then click Display.  
2. Click the Appearance tab, and then click Effects.  
3. Select the Use the following method to smooth edges of screen fonts check box, 

and then click ClearType.   
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Reading Layout view 
If users are opening a document primarily for reading, Reading Layout view optimizes 
the reading experience. Reading Layout view hides all of the toolbars except for the 
Reading Layout and Reviewing toolbars. Because the goal of Reading Layout view is to 
increase legibility, pages that are represented in this view are designed to fit well on the 
screen, and the text is automatically displayed by using Microsoft ClearType technology. 
Users can easily increase or decrease the size in which text is shown without affecting 
the size of the font in the document.  

If users want to modify the document, they can simply edit text while reading without 
switching out of Reading Layout view. The Reviewing toolbar is automatically displayed 
in this view, so users can easily use change tracking and comments to mark up a 
document. 

 
To improve the reading experience, the pages in Reading Layout view fit well on-screen, and the 
text is displayed by using Microsoft ClearType technology. 

How to switch to the Reading Layout view 

1. Click the Read button on the Standard toolbar. 

2. To stop using the Reading Layout view, click the Close button on the 
Reading Layout toolbar, or press ESC, or press ALT+C.   

-or- 
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1. Press ALT+R in any view in Word. 

2. To stop using the Reading Layout view, click the Close button on the 
Reading Layout toolbar, or press ESC, or press ALT+C.   

Merge enhancements 
The Mail Merge task pane helps users create form letters, mailing labels, envelopes, 
directories, mass e-mail, and fax distributions. The Mail Merge Wizard is easy to use and 
provides step-by-step instructions, but users can also take advantage of the Mail Merge 
toolbar. In either case, users can follow the process by looking at the numbered steps at 
the bottom of the Mail Merge task pane. 

 
Use the Mail Merge task pane to create mass e-mails or mailing labels. 

 

How to open the Mail Merge task pane 

1. On the Tools menu, point to Letters and Mailings, and then click Mail Merge.   
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Track changes enhancements 
To make online review easier, Word 2003 allows users to make and view tracked 
changes and comments in a document. To preserve the layout of a document, 
Word 2003 shows some markup elements in the text of the document while others are 
contained in balloons that appear in the margin. The Reviewing Pane shows an outline 
of all the edits in a list format at the bottom of the screen. 

With the Track Changes feature turned on, each insertion, deletion, or formatting 
change that a reviewer makes is tracked. As tracked changes are reviewed, users can 
accept or reject each change. Users can also use the Display for Review drop-down box 
to view the document during various stages of the review process.   

 
Turn on Track Changes when reviewing a document. 

 

How to track changes 

On the Tools menu, click Track changes to open the Reviewing toolbar. 
-or- 
Click the Track Changes button.   

 

 
Select the desired review setting for a document. 

How to view the document during various stages of the review process 

On the Reviewing toolbar, select the desired setting from the Display for Review drop-
down list.  
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Ink support 
If users are working on a Microsoft Tablet PC, they can use a tablet pen to add drawings 
or handwritten notes to Word 2003 documents—in comments, in the content of a 
document, or as annotations about content that already exists in the document. 

 
With a Tablet PC, handwritten comments can be added to a Word document. 
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How to use ink 

To write directly in a document:   

1. On the Insert menu, point to Picture. 
2. Tap Ink Drawing and Writing.   
 

To insert an ink comment:   

On the Insert menu, tap Ink Comment.   

 

Use one of these methods to make ink annotations:   

1. From the Print Layout view, go to the Insert menu. 
2. Tap Insert Ink Annotation.   
3. Mark up the document similar to how you would do so on paper. When you are 

finished, tap Stop Inking on the Ink Annotations toolbar. 
-or- 

1. From the Reading Layout view, go to the Reading Layout toolbar.  
2. Tap Actual Page.  
3. On the Reviewing toolbar, tap Insert Ink Annotations. 
4. Mark up the document similar to how you would do so on paper. When you are 

finished, tap Stop Inking on the Ink Annotations toolbar. 
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Formatting Restrictions 
In Word 2003, users can specify and enforce template or document styles by using the 
Formatting Restrictions feature. All direct formatting will be disabled. Complex 
documents can be edited by many people and still retain structured formatting. 

 
Use the Protect Document task pane to specify the styles that a template or document uses. 

 

How to restrict formatting 

1. On the Tools menu, click Protect Document.  
2. In the Protect Document task pane, under Formatting restrictions, select the Limit 

formatting to a selection of styles check box, and then click Settings. 
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Editing Restrictions 
With editing restrictions in Word 2003, users can protect portions of a document against 
editing by some or all users. Editing restrictions options include protecting the entire 
document against any edits, allowing only comments, and assigning permissions to 
individual portions of the document by selecting them and choosing which users can 
edit a designated area. Later, when reconciling the changes of different individuals, 
users are assured that no two people edited the same area and that no conflicts exist. 

After the restrictions have been set up, the Protect Document task pane helps users find 
the sections that they can edit. 

 
Set the restrictions on all or portions of a document. 
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How to restrict editing 

1. On the Tools menu, click Protect Document.  
2. In the Protect Document task pane, select the Editing restrictions check box, and 

then click one of the following:  
No changes (read only) (if you want to prevent users from changing the document)  
-or-  
Comments (if you want to allow users to insert comments into the document but 
not change the content of the document)  
-or-  
Track Changes (if you want to allow users to insert comments into the document 
and add tracked changes)  
-or-  
Filling in forms (if you want to allow users to fill in a form but not make changes to 
the form)  

3. If you select No changes (read only) or Comments, go to the Exceptions area and 
assign permissions to individual portions of the document by selecting those 
portions and then choosing which users can edit them. 

4. If you select Filling in forms, you can remove protection from sections of the form 
by clicking Select sections and clearing the checkboxes for those sections you do not 
want to protect. To protect only parts of a form, those parts must be in separate 
sections. 

5. Click Yes, Start Enforcing Protection. 
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Excel 2003 
Excel 2003 offers several new features to its users. These new features are individually 
described within the following sections. 

List data integration with Windows SharePoint Services 
Through integration with Windows SharePoint Services, Excel 2003 lists make it easy to 
share data with other users. If the user has the Web address and authoring rights on a 
SharePoint site, the list can be shared so that other people can view, edit, and update it. 
If the user opts to link the list in Excel 2003 to a list on a SharePoint site, users can edit 
that list offline and synchronize changes with the SharePoint site at a later time so that 
other users can see updated data. 

To manage the synchronization between the local Excel list and the SharePoint list, the 
List toolbar provides two buttons that allow users to choose how they want to handle 
updates to the list.  

Synchronize Excel lists and SharePoint lists using the List toolbar. 

 
Synchronizing lists 

To publish any local changes to the SharePoint list, and transfer any changes that were 
made to the SharePoint list to the local Excel list, complete the following step:   

On the List toolbar, click Synchronize List . 
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To discard local changes to the list, and download the current copy of the list from the 
Microsoft Windows SharePoint Services Web site, complete the following step:   

On List toolbar, click Discard Changes and Refresh   

Using Improved Standard Deviation computation 
Standard Deviation functionality in Excel estimates standard deviation based on a 
sample. The standard deviation is a measure of how widely values are dispersed from 
the average value (the mean). 

The procedure used in Excel 2003 uses a two-pass process through the data. First, the 
sum and count of the data values are computed and from these the sample mean 
(average) can be computed. Then, on the second pass, the squared difference between 
each data point and the sample mean is found and these squared differences are 
summed.  

• Prior versions of Excel Standard Deviation Syntax = STDEV(number 1, number 2, 
etc)  

• Excel 2003 Standard Deviation Syntax = SQRT(DEVSQ(values)/(COUNT(values) – 
1))  

Smart tag integration 
Users can save time by using smart tags to perform actions in Excel 2003 that used to 
require other programs. Smart tags recognize certain types of text and then offer 
related functions and commands. 

A smart tag can help users take advantage of external resources. For example, when a 
U.S. financial symbol such as "MSFT" is typed in a cell, the Smart Tag Actions button 
provides a list of available smart tag actions. Users can click the smart tag (the purple 
triangle in the corner of a worksheet cell), and then select the action "Recent news on 
MSN Money Central." The browser opens to a Web page that contains news and 
information about the company. When finished, the user can close the browser and 
continue to work in Excel 2003. 
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Select the types of smart tags to recognize and specify their appearance. 

 

How to use smart tags 

To turn on smart tags:   

1. On the Tools menu, click AutoCorrect Options.  
2. Click the Smart Tags tab, and then select the Label data with smart tags check box. 
 

To select a smart tag action:  

1. Cells with smart tags are indicated by a purple triangle in the lower-right corner of 
the cell. Move the cursor over the purple triangle in a cell until Smart Tag Actions 

 appears.  
2. Click the arrow. The actions that can be performed appear in a list.  
3. Select an action. 
 

To find more smart tags, complete the following step:   

1. On the Tools menu, click AutoCorrect Options. 
2. Click the Smart Tags tab. 
3. Click More Smart Tags to go to Web sites to find new smart tags and actions. 
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PowerPoint 2003 
PowerPoint 2003 offers several new features to its users. These new features are 
individually described within the following sections. 

Smart tag integration 
Users can save time by using smart tags to perform actions in PowerPoint 2003 that 
used to require other programs. Smart tags recognize certain types of text and then 
offer related functions and commands. With PowerPoint 2003, users can embed smart 
tags so that they are available to anyone who opens the presentation.  

Users might find additional smart tags created by Microsoft, by third-party companies, 
or by Information Technology (IT) professionals who design smart tags and actions for 
the specific products or services that are relevant to their activities. 

 
Select the types of smart tags to recognize and specify their appearance. 

 

How to use smart tags 

To turn on smart tags:   

1. On the Tools menu, click AutoCorrect Options.  
2. Click the Smart Tags tab, and then select the Label text with smart tags check box. 
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To select a smart tag action:   

1. Move the insertion point over text that is underlined with a purple dotted line until 

Smart Tag Actions  appears.  
2. Click the arrow. The actions that can be performed appear in a list.  
3. Select an action. 
 

To find more smart tags, complete the following step:   

1. On the Tools menu, click AutoCorrect Options.  
2. Click the Smart Tags tab. 
3. Click More Smart Tags to go to Web sites to find new smart tags and actions. 

Thesaurus integration 
PowerPoint 2003 now includes a thesaurus that is integrated into the Research task 
pane. When the integrated thesaurus is opened, a list of suggested synonyms appears. If 
users select a word from the list, that word replaces the selected term in the text. If the 
list does not contain an appropriate synonym, the user can select Thesaurus from the 
list to open the full thesaurus and continue the search. 

 
Use the integrated thesaurus to find just the right word. 
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How to open the integrated thesaurus 

Right-click on a word, select Synonyms, and then select Thesaurus. 
-or- 
Click Tools, and then click Thesaurus. 
-or- 
Hold down ALT, and then click on a word. 

Ink support 
For users working with a Tablet PC, ink support is available with the tablet pen. Users 
can add ink while delivering a presentation, or while editing slides. If users are creating 
or editing slides, they can add ink drawing and writing to emphasize certain portions of 
a slide, or use handwriting or hand-drawn pictures to design the overall layout of the 
information. Ink can be inserted in the following PowerPoint views: 

• Normal view 
• Notes Page view 
• Slide Master view 
• Handout Master view 
• Notes Master view 
• Slide Show view 

 
Add ink to PowerPoint slides. 
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How to use ink to edit slides 

On the Insert menu, tap Ink Drawing and Writing.  

Annotations in Slide Show view 
PowerPoint 2003 has improved annotation support. Tablet PC users can mark slides 
with ink while in Slide Show view. Users can make comments or answer questions that 
are asked during the presentation by adding them directly to the slides. Users can also 
take notes on slides, and save the ink on the slides for later use.  

PowerPoint 2003 has also updated the pen tools in slide show with more colors and 
types of pens to choose from, in addition to giving the user the ability to highlight parts 
of the presentation by using a new highlighter tool.  

 
Make comments directly in a slide using Ink. 

 

How to make annotations while in Slide Show view 

1. Place the tablet pen or mouse over the pen icon on the lower right of the slide. 
2. Tap or click the arrow on the slide show toolbar, and then tap or click Ballpoint Pen, 

Felt Tip Pen, or Highlighter.  
3. To cancel the selection of ink, click or tap away from the selected ink. 
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Expanded playlist formats 
PowerPoint 2003 now supports the following audio playlist formats: ASX, WMX, M3U, 
WVX, WAX, and WMA. Also, if a media codec (software that is necessary to play the 
selected files) is not available, PowerPoint 2003 tries to download it from the Web by 
using Microsoft Windows Media® Player technology.   

 
Insert a supported playlist into a presentation. 

 

How to insert a playlist in a slide 

1. On the Insert menu, point to Movies and Sounds. 
2. Click Sound from File.  
3. Find the folder that contains the playlist to be inserted, and then double-click the 

playlist. 
 

How to find more sounds, movies, and clip art 

1. On the Insert menu, point to Movies and Sounds. 
2. Click Sound from Clip Organizer or Movie from Clip Organizer. 
3. In the Clip Art task pane, click Clip art on Office Online. 
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Full-screen playback 
Movies that are embedded in a slide can now play across the entire screen during a slide 
show. To enable this feature, users select the check box in the Movie Options dialog 
box. Alternatively, users can leave the check box cleared if they want the movie to play 
in a rectangle within the slide. 

 
Use the new setting in the Movie Options dialog box for full-screen playback in a slide show. 

 

How to select full-screen playback 

Use either of these methods to select full-screen playback:   

1. Right-click on the movie. 
2. Select Edit movie object from the context menu. 
3. Select the Zoom to full screen check box. 
-or- 

1. In the Custom Animation task pane, click the Play effect.  
2. On the Gallery menu, select Effect Options. 
3. Click the Movie Settings tab, and then select the Zoom to full screen check box. 
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PowerPoint Viewer and Package for CD 
The PowerPoint Viewer displays presentations exactly as the author created them, even 
on systems that do not have PowerPoint 2003 installed. By using PowerPoint Viewer, 
users can open protected presentations by using a password, and can print 
presentations. The new PowerPoint Viewer is an improved version of the Microsoft 
PowerPoint Viewer 97. 

PowerPoint Viewer is, by default, part of the “Package for CD” feature. With this 
feature, users can package presentations onto a CD, and distribute PowerPoint 
presentations without worrying if the recipients have the correct version of PowerPoint 
for viewing. Users can also choose to have the CD play presentations automatically 
when the CD is inserted into a computer. 

 
When a presentation is packaged on a CD, even computers that do not have PowerPoint installed 
can view it. 

 

How to package a presentation for CD 

On the File menu, click Package for CD. 
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Access 2003 
Access 2003 offers several new features to its users. These new features are individually 
described within the following sections. 

List data integration with Windows SharePoint Services 
If Windows SharePoint Services is configured and available, integration with 
Access 2003 requires no special setup, customization, or other actions. Access 2003 
integration with Windows SharePoint Services makes the following tasks possible: 

• Export the contents of a table from Access 2003 to a list in Windows SharePoint 
Services. 

• Import the contents of a list in Windows SharePoint Services into a table in 
Access 2003. 

• Create a linked table in Access 2003 that gets live data from a list in Windows 
SharePoint Services. 

 
Export Access 2003 data to a SharePoint site. 
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How to work with lists 

To export tables or queries to lists in Windows SharePoint Services, complete the 
following steps:   

1. Start Access 2003. 
2. Open the database to export from. 

3. In the database windows, select the table or query to export, click File on the Access 
toolbar, and then click Export. 

4. Select Windows SharePoint Services from the Save as Type dropdown menu.  

5. Use the Export to Windows SharePoint Services Wizard to complete the operation. 
 

To import data from lists or views of a list in Windows SharePoint Services, complete the 
following steps:   

1. In the database window, click File on the Access toolbar.  
2. Click Get external data, then Import.  

3. Select Windows SharePoint Services from the Files of Type dropdown menu. 

4. Use the Import from Windows SharePoint Services Wizard to complete the 
operation. 

 

To link to data from lists or views of a list in Windows SharePoint Services, complete the 
following steps:   

1. In the database window, click File on the Access toolbar.  
2. Click Get external data, then Link Tables.  

3. Select Windows SharePoint Services from the Files of Type dropdown menu. 

4. Use the Link to Windows SharePoint Services Wizard to complete the operation. 
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Smart tag integration 
Users can save time by using smart tags to perform actions in Access 2003 that are 
typically completed by other programs. Smart tags can be attached to a field in a table 
or query, or to controls in a form.  

Microsoft provides a set of ready-to-use smart tags with Access 2003. Users can also 
create their own smart tags. Visit the Office Developer Center on the Microsoft 
Developer Network (MSDN®) Web site for more information about creating smart tags 
for use with Access 2003. 

 
Add smart tags to any database field. 
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How to use smart tags 

To add smart tags to a form:   

1. Open a form in Design View. 
2. Select a text box, list box, combo box, or label. 

3. Click Properties on the toolbar, select the Smart Tags property on the Data tab, 

and then click the Build button . 

 

To add smart tags to a table:   

1. Open a table in Design View. 
2. Select the field that you would like to add a Smart Tag to. 

3. Select the Smart Tags property on the General tab, and then click the Build button 

. 

 

To select a smart tag action:   

1. After a smart tag has been added to a field or control, the Smart Tag Actions  
button appears when a cell in the field or the control is activated.  

2. Click the button to see the menu of actions that are possible with the smart tag. 
To get more smart tags, complete the following step:   

1. Create a new form in Design View.  

2. Add a Text Box to the form and then click Properties  on the toolbar.  

3. Click the Build button  for the Smart Tags property, and then click More Smart 
Tags. 
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Back up a database 
Users can back up critical Access database files from within Access 2003. These database 
files are saved to a consistent location on a local system or shared network. The name of 
the backup file is based on the current date. As part of the backup operation, the 
Compact and Repair action is performed to make sure that the database is internally 
consistent. 

 
Use this simple menu selection to back up critical Access database files. 

 

How to back up an Access database 

1. Save and close all objects in the database.  
2. On the File menu, click Back Up Database. 
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AutoCorrect option 
In Access 2003, the AutoCorrect Smart Tag appears whenever AutoCorrect occurs. 
AutoCorrect works for the Text Box and the Combo Box controls when in Form View, 
and for all fields when in Datasheet View.  

Users have extensive control of the functions of AutoCorrect. To reject the changes of 
AutoCorrect, users can work with the Undo, Stop, and Control AutoCorrect Options for 
each of the scenarios.  

The AutoCorrect scenarios are: 

• Correct TWo INitial Capitals 
• Capitalize the first letter of sentences 
• Capitalize the names of days 
• Correct accidental use of cAPS LOCK key 
• Replace text as you type 

 
All of the checked options are automatically corrected while the user types. 

 

How to set AutoCorrect options 

On the Tools menu, click AutoCorrect Options. 
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Dependent Objects 
Using this feature, users can keep track of which database objects depend on the 
database object that is being modified. Tracking name AutoCorrect information must be 
turned on to view dependency information, and this information is generated only for 
tables, queries, forms, and reports in an Access database. The new Dependent Objects 
feature makes it easy to determine the dependents of any object in an Access database, 
which reduces the troubleshooting time that is needed to make a modification to an 
existing Access application. This feature is only available in a Microsoft Access database 
(*.mdb). 

When users open the Dependency pane, a list of objects that use the selected object 
appears. To view the list of objects that are being used by the selected object, users can 
click "Objects that I depend on" at the top of the pane. To view dependency information 
for an object listed in the pane, simply click on the expand icon (+) that appears next to 
the object.  

 
Use the Dependent Objects feature to determine the dependents of any object in an Access 
database. 

 

How to view Dependent Objects 

1. Right-click a Table, Query, Form, or Report.  
2. Click Object Dependencies. 

-or- 
Click View, and then click Object Dependencies. 
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Font Control for the SQL Window 
In an Access database, the font can be changed in SQL and Query Design view. These 
font settings apply to Access 2003 as a whole. 

 
Select the appropriate font in the Query design font area. 

 

How to change the font in SQL and Query Design view 

1. On the Tools menu, click Options. 
2. Click the Tables/Queries tab. 
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Error checking 
In Access 2003, automatic error checking points out errors in a form or report, and 
provides options for correcting them. For example, when two controls use the same 
keyboard shortcut, or when the width of a report is greater than the page on which it 
will be printed, the error-checking feature automatically highlights the error. The error 
appears as a smart tag. The following are some of the error-checking smart tags: 

• Unassociated Label 
• New Unassociated Label 
• Unassociated Label with Accelerator (Form Only) 
• Duplicate Accelerator (Form Only) 
• Invalid Accelerator (Form Only) 
• Invalid Control Source 
• Circular Reference 
• Duplicate Option Value 
• Invalid Sorting and Grouping (Report Only) 
• The report width is greater than the page width 

 
Select the types of errors that Access should look for in a form or report. 
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Correct an error by selecting an option from the menu. 

 

How to use error checking 

To turn on error checking:   

1. On the Tools menu, click Options. 
2. Click the Error Checking tab.  
3. Under Settings, select the Enable error checking check box. 
 

To correct an error:   

1. Select the control that has an error indicator.  
2. Rest the pointer on the Error Checking Options button.  
3. Click the arrow in the button. 
4. Select an option from the menu that appears. 
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Making a local table 
Copying a linked table into the local database is a common technique for optimizing 
performance for slow-running reports that use linked tables or queries. In previous 
versions of Access, users had to create a complex Make Table query to perform this 
task. Now, users can simply copy the linked table to the clipboard and paste it back into 
the database, or find this action in the task pane as a common task for Linked Tables. 

 
Copy a linked table and paste it into a database to create a local table. 

 

How to make a local table 

1. In the Database window, select the linked table to convert to a local table.  
2. Copy the table, and then paste it.  
3. Type the name for the new table in the Table Name box, and then select whether to 

create a Linked Table, an empty table (click Structure Only), or to keep the data 
from the linked table also (click Structure and Data). 
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Propagating field properties 
In Access 2003, when an inherited field property in the Table Design view is modified, 
users now have the option to update the property of all or some controls that are bound 
to that field.  

In the past, developers had to go through each related object and set the property 
manually. This new feature means that a property is modified in only one place, saving 
time and reducing the risk of forgetting to update an object.  

Whenever an inherited field property is modified in the Table Design view, the Property 
Update Options smart tag appears, and the user has the option to update that property 
everywhere that field is used.  

 
Propagate the property of all or some controls that are bound to an inherited field. 

 

How to propagate inherited properties 

1. If the value of an inherited property is changed, the Property Update Options 
button appears next to the property name.  

2. Click the Property Update Options button. 
3. Click the Update command. 
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XML Glossary 
XML — Extensible Markup Language is a metadata definition language that is used to describe 
data in a structured open format. 

XML Schema — Valid XML files that is used to define the structure for other XML Files.  

XPATH — An XML Query language that is used to extract elements and data easily from complex 
XML documents. 

XSD — The XML Schema Definition file. 

XSL — Extensible Stylesheet Language. 

XSLT — Extensible Stylesheet Transform files are used to transform the format or content of 
existing XML files. 

Namespace — An XML namespace is a collection of element type and attribute names that are 
identified by the name of the unique XML namespace of which they are a part. 

Smart document — A Word 2003 or Excel 2003-based solution that combines an underlying 
XML structure with custom code to enable special actions within the document. Actions are 
based on where the cursor is placed within the document and can include context-sensitive help 
information, data retrieval, formatting actions, and others. 

Smart tags — User-interface icons that dynamically recognize data and present information 
workers with actions that are based on that data. 

Solution Manifest — An XML file that describes the locations and behaviors of a particular 
solution's component files. 

Valid XML — An XML document with elements and attributes that match the logical structure 
and data types that are defined in a particular schema. 

Well-formed XML — XML that has accurate beginning and ending tags, and containment 
relationships; that is, the XML conforms to the Worldwide Web Consortium (W3C) XML 
specification. 


